CAD Integration
Copyright and Trademark Information

© 2017 ANSYS, Inc. Unauthorized use, distribution or duplication is prohibited.

ANSYS, ANSYS Workbench, AUTODYN, CFX, FLUENT and any and all ANSYS, Inc. brand, product, service and feature names, logos and slogans are registered trademarks or trademarks of ANSYS, Inc. or its subsidiaries located in the United States or other countries. ICEM CFD is a trademark used by ANSYS, Inc. under license. CFX is a trademark of Sony Corporation in Japan. All other brand, product, service and feature names or trademarks are the property of their respective owners. FLEXlm and FLEXnet are trademarks of Flexera Software LLC.

Disclaimer Notice

THIS ANSYS SOFTWARE PRODUCT AND PROGRAM DOCUMENTATION INCLUDE TRADE SECRETS AND ARE CONFIDENTIAL AND PROPRIETARY PRODUCTS OF ANSYS, INC., ITS SUBSIDIARIES, OR LICENSORS. The software products and documentation are furnished by ANSYS, Inc., its subsidiaries, or affiliates under a software license agreement that contains provisions concerning non-disclosure, copying, length and nature of use, compliance with exporting laws, warranties, disclaimers, limitations of liability, and remedies, and other provisions. The software products and documentation may be used, disclosed, transferred, or copied only in accordance with the terms and conditions of that software license agreement.

ANSYS, Inc. and ANSYS Europe, Ltd. are UL registered ISO 9001: 2008 companies.

U.S. Government Rights

For U.S. Government users, except as specifically granted by the ANSYS, Inc. software license agreement, the use, duplication, or disclosure by the United States Government is subject to restrictions stated in the ANSYS, Inc. software license agreement and FAR 12.212 (for non-DOD licenses).

Third-Party Software

See the legal information in the product help files for the complete Legal Notice for ANSYS proprietary software and third-party software. If you are unable to access the Legal Notice, contact ANSYS, Inc.

Published in the U.S.A.
# Table of Contents

**Overview** .......................................................................................................................... 1  
Introduction ............................................................................................................................... 2  
Geometry Interface Support ......................................................................................................... 3  
- Linux .................................................................................................................................. 5  
- Windows ............................................................................................................................... 7  
- Project Schematic Presence Related to CAD Integration ....................................................... 9  
- Geometry Preferences .......................................................................................................... 9  
- Compare Parts on Update ...................................................................................................... 20  
- Mixed Import Resolution ........................................................................................................ 21  
- CAD Configuration Manager ............................................................................................... 22  
- Named Selection Manager .................................................................................................... 22  
- Caveats and Known Issues .................................................................................................... 25  

**Installation and Licensing** ................................................................................................ 27  

**AIM Interoperability** ........................................................................................................ 29  

**File Format Support** .......................................................................................................... 31  
- ACIS (*.sat, *.sab) .................................................................................................................. 32  
- ANSYS Part Manager (*.pmdb) ............................................................................................ 34  
- AutoCAD (*.dwg, *.dxf) .......................................................................................................... 34  
  - AutoCAD Reader (*.dwg, *.dxf) .......................................................................................... 34  
  - AutoCAD Associative Geometry Interface (*.dwg, *.dxf) ................................................... 36  
- Autodesk Inventor (*.ipt, *.iam) ............................................................................................ 38  
  - Autodesk Inventor Reader (*.ipt, *.iam) ............................................................................. 38  
  - Autodesk Inventor Associative Geometry Interface (*.ipt, *.iam) .................................... 40  
- CATIA (*.model, *.exp, *.session, *.CATPart, *.CATProduct) ........................................... 43  
  - CATIA V4 Reader (*.model, *.exp, *.session) ................................................................. 43  
  - CATIA V5 Reader (*.CATPart, *.CATProduct) ............................................................... 45  
  - CATIA V5 Associative Geometry Interface (*.CATPart, *.CATProduct) ....................... 49  
- CATIA V6 Reader (*.3dxml) ................................................................................................. 52  
- Creo Parametric (*.prt, *.asm) ............................................................................................ 56  
  - Creo Parametric Reader (*.prt, *.asm, *.asm.*) ............................................................ 56  
  - Creo Parametric Associative Geometry Interface (*.prt, *.asm) ..................................... 59  
- ANSYS DesignModeler (*.agdb) .......................................................................................... 66  
- GAMBIT (*.dbs) .................................................................................................................... 70  
- IGES (*.igs, *.iges) .............................................................................................................. 72  
- JT Reader (*.jt) ..................................................................................................................... 74  
- Monte Carlo N-Particle (*.mcnp) .......................................................................................... 76  
- NX (*.prt) ............................................................................................................................ 77  
  - NX Reader (*.prt) .............................................................................................................. 77  
  - NX Associative Geometry Interface (*.prt) ....................................................................... 79  
- Parasolid (*.x_t, *.xmt_txt, *.x_b, *.xmt_bin) ..................................................................... 83  
- Rhinoceros (*.3dm) .............................................................................................................. 85  
- SketchUp (*.skp) .................................................................................................................. 87  
- Solid Edge (*.par, *.asm, *.psm, *.pwd) .......................................................................... 88  
  - Solid Edge Reader (*.par, *.asm, *.psm) ....................................................................... 88  
  - Solid Edge Associative Geometry Interface (*.par, *.asm, *.psm, *.pwd) .................... 90  
- SolidWorks (*.sldprt, *.sldasm) ......................................................................................... 94  
  - SolidWorks Reader (*.sldprt, *.sldasm) ......................................................................... 94  
  - SolidWorks Associative Geometry Interface (*.sldprt, *.sldasm) ................................... 96  
- SpaceClaim (*.scdoc) ............................................................................................................ 99
CAD Integration Overview

ANSYS Workbench is a CAD-neutral environment that supports bidirectional, direct, and associative geometry interfaces (plug-ins (p. 123)) with CAD systems as well as non-associative interfaces (readers) that generally do not require the CAD be installed. The readers (p. 123) and associative geometry interfaces (p. 123) are not interchangeable. The specific import options that are supported can be viewed at Geometry Preferences (p. 9).

The plug-ins support import/update without translation to the intermediate geometry formats. The associative geometry interfaces allow you to make parametric changes in a CAD system or drive those changes from within ANSYS Workbench and when the geometry is updated assigned scopings will persist if the topology is present in the updated model. The Named Selection Manager (p. 22), available in most integrated CAD systems, provides a means to create custom selections within the CAD systems for use in modeling, meshing, and analysis.

Readers, with the exception of the CAPRI interface, do not require the CAD system to be present to import geometry files. These interfaces however, are not associative, nor bi-directionally parametric.

ANSYS CAD integration supports the Smart CAD Update, where supported by the CAD, and Selective Update of CAD parts instead of updating an entire model. All interfaces can update the model using Compare Parts on Update (p. 20) and those parts that are not modified will maintain their existing mesh so it does not need to be regenerated.

Bidirectional CAD Connections

- AutoCAD (*.dwg, *.dxf) (p. 34)
- CATIA V5 Associative Geometry Interface (*.CATPart, *.CATProduct) (p. 49)
- Creo Parametric Associative Geometry Interface (*.prt, *.asm) (p. 59)
- Autodesk Inventor Associative Geometry Interface (*.ipt, *.iam) (p. 40)
- NX Associative Geometry Interface (*.prt) (p. 79)
- Solid Edge (*.par, *.asm, *.psm, *.pwd) (p. 88)
- SolidWorks Associative Geometry Interface (*.sldprt, *.sldasm) (p. 96)

Integrated Product Management Interface

- CAD Integration ANSYS Teamcenter Connection (p. 103)

CAD Readers

- ACIS (*.sat, *.sab) (p. 32)
- AutoCAD Reader (*.dwg, *.dxf) (p. 34)
- Autodesk Inventor Reader (*.ipt, *.iam) (p. 38)
- CATIA V4 Reader (*.model, *.exp, *.session) (p. 43)
- CATIA V5 Reader (*.CATPart, *.CATProduct) (p. 45)
- CATIA V6 Reader (*.3dxml) (p. 52)
- Creo Parametric Reader (*.prt, *.prt.*, *.asm, *.asm.*) (p. 56)
**Geometry Export**

- IGES (*.igs, *.iges) (p. 72)
- ANSYS MAPDL (*.anf)
- Monte Carlo N-Particle (*.mcnp) (p. 76)
- Parasolid (*.x_t, *.xmt_txt, *.x_b, *.xmt_bin) (p. 83)
- STEP (*.stp, *.step) (p. 100)

For more detailed information about ANSYS CAD:

- Introduction (p. 2)
- Geometry Interface Support (p. 3)
- Project Schematic Presence Related to CAD Integration (p. 9)
- Mixed Import Resolution (p. 21)
- CAD Configuration Manager (p. 22)
- Named Selection Manager (p. 22)
- Caveats and Known Issues (p. 25)
- CAD Integration Installation and Licensing (p. 27)
- CAD Integration File Format Support (p. 31)
- CAD Integration SpaceClaim (p. 111)
- CAD Integration Frequently Asked Questions (p. 117)
- CAD Integration Troubleshooting (p. 119)
- CAD Integration Glossary (p. 123)
- CAD Integration Updates (p. 125)

**Introduction**

With the understanding that all engineering simulation is based on geometry to represent the design, there are several methods of accessing CAD models within ANSYS Workbench, depending upon the level of integration and the interface products licensed at your site.

**Starting from within ANSYS Workbench**

To start from within ANSYS Workbench, double-click **Geometry** in the **Component Systems** toolbox. You can also select **Geometry** in the **Component Systems** toolbox and drag it to the **Project Schematic**. Additionally, any system that contains a geometry cell can be used (e.g. Static Structural).

**Access via ANSYS DesignModeler or ANSYS SpaceClaim Direct Modeler**
For **Geometry** access via Workbench-integrated applications ANSYS **DesignModeler** or ANSYS SpaceClaim Direct Modeler, right-click to select **New Design Modeler Geometry** or **New SpaceClaim Direct Modeler Geometry**, or browse to a geometry file.

**Access via CAD system**

For **Geometry** access via CAD system with Associative reader, or CAD system with plug-in (p. 123), right-click to select **Import Geometry**, then **Browse** to a geometry file OR select a model from the active documents.

For **Geometry** access via CAD file with reader (p. 123), right-click to select **Import Geometry**, then **Browse** to a geometry file.

**Starting from within the CAD System**

For **Geometry** access via a CAD system with plug-in (p. 123), start ANSYS Workbench by selecting the ANSYS pull-down menu from the CAD system’s toolbar.

ANSYS Workbench will open and automatically create a new **Geometry** system on the **Project Schematic**.

**Geometry Interface Support**

When installing ANSYS Workbench, you may select specific CAD systems in the ANSYS Geometry Interfaces section.
Your installation options were pre-selected based upon information from your license server. Review and select the product(s) you wish to install.

Information about past, present and future platform support is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Matrices for supported CAD systems on ANSYS Workbench at the time of release:

Linux
Windows
## Linux

<table>
<thead>
<tr>
<th>Reader/Plug-In</th>
<th>Versions of CAD Package</th>
<th>Operating System</th>
<th>Supported Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Red Hat 6</td>
<td>Red Hat 7</td>
</tr>
<tr>
<td><strong>READERS</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACIS</td>
<td>2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Autodesk AutoCAD</td>
<td>2016</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CATIA V4</td>
<td>4.2.4</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CATIA V5</td>
<td>V5–6R2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CATIA V6</td>
<td>R2016x</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creo Parametric</td>
<td>Cro Parametric 3.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GAMBIT</td>
<td>2.4.6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IGES</td>
<td>4.0, 5.2, 5.3</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Autodesk Inventor</td>
<td>2017</td>
<td></td>
<td></td>
</tr>
<tr>
<td>JT</td>
<td>10.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Monte Carlo N-Particle</td>
<td></td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>NX</td>
<td>11</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Parasolid</td>
<td>29.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rhinoceros</td>
<td>V5.020</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SketchUp</td>
<td>V2014</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solid Edge</td>
<td>ST9</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SolidWorks</td>
<td>2017</td>
<td></td>
<td></td>
</tr>
<tr>
<td>STEP</td>
<td>AP203, AP214</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>PLUG-INS/PSEUDO-READER</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autodesk AutoCAD</td>
<td>2018</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reader/Plug-In</td>
<td>Versions of CAD Package</td>
<td>Operating System</td>
<td></td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------</td>
<td>---------------------------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Red Hat 6</td>
<td>Red Hat 7</td>
</tr>
<tr>
<td><strong>Supported Platform</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creo Elements/Direct Modeling</td>
<td>19.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>18.1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creo Parametric</td>
<td>Creo Parametric 4.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Creo Parametric 3.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Creo Parametric 2.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autodesk Inventor</td>
<td>2018</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td></td>
<td></td>
</tr>
<tr>
<td>NX</td>
<td>11.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9.0</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Solid Edge</td>
<td>ST9</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ST8</td>
<td></td>
<td></td>
</tr>
<tr>
<td>SolidWorks</td>
<td>2017</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**INTEGRATED PRODUCT MANAGEMENT CONNECTIONS**

| Teamcenter 1                      | Unified Architecture 11.2.2      |           |           |                  |                         |
|                                   | (2- & 4-tier) with               |           |           |                  |                         |
|                                   | NX 11.0 only                     |           |           |                  |                         |
|                                   | Unified Architecture 11.2       |           |           |                  |                         |
|                                   | (2- & 4-tier) with               |           |           |                  |                         |
|                                   | NX 10.0 or higher               |           |           |                  |                         |
|                                   | Unified Architecture 10.1.0.1   |           |           |                  |                         |
|                                   | with                            |           |           |                  |                         |
|                                   | NX 9.0                          |           |           |                  |                         |

√ = supported

1. not supported with AIM
# Geometry Interface Support

## Windows

<table>
<thead>
<tr>
<th>Reader/Plug-In</th>
<th>Versions of CAD Package</th>
<th>Operating System</th>
<th>Supported Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Windows 7</td>
<td>Windows 8.1</td>
</tr>
<tr>
<td>REaders</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ACIS</td>
<td>2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Autodesk AutoCAD</td>
<td>2016</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CATIA V4</td>
<td>4.2.4</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CATIA V5</td>
<td>V5–6R2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>CATIA V6</td>
<td>R2016x</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Creo Parametric</td>
<td>Creo Parametric 4.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>GAMBIT</td>
<td>2.4.6</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>IGES</td>
<td>4.0, 5.2, 5.3</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Autodesk Inventor</td>
<td>2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>JT</td>
<td>10.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Monte Carlo N-Particle</td>
<td>1</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>NX</td>
<td>11.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Parasolid</td>
<td>29.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Rhinoceros</td>
<td>V5.020</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SketchUp</td>
<td>V2014</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Solid Edge</td>
<td>ST9</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>SolidWorks</td>
<td>2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>STEP</td>
<td>AP203, AP214</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>PLUG-INS/PSEUDO-READER</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Autodesk AutoCAD</td>
<td>2018</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Creo Elements/Direct Modeling</td>
<td>20.0</td>
<td>✓</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>19.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Creo Parametric</td>
<td>Creo Parametric 4.0</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Reader/Plug-In</td>
<td>Versions of CAD Package</td>
<td>Operating System</td>
<td></td>
</tr>
<tr>
<td>---------------</td>
<td>-------------------------</td>
<td>------------------</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Windows 7</td>
<td>Windows 8.1</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Intel EM64T, AMD64</td>
<td></td>
</tr>
<tr>
<td><strong>Readers</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Creo Parametric 3.0</td>
<td>√</td>
<td>√</td>
<td>√ 4</td>
</tr>
<tr>
<td>Creo Parametric 2.0</td>
<td>√ 5</td>
<td>√ 5</td>
<td>√ 8</td>
</tr>
<tr>
<td><strong>Autodesk Inventor</strong></td>
<td>2018</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2017</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td><strong>NX</strong></td>
<td>11.0</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td></td>
<td>10.0</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td></td>
<td>9.0</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td><strong>Solid Edge</strong></td>
<td>ST9</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td></td>
<td>ST8</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td><strong>SolidWorks</strong></td>
<td>2017</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2016</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td><strong>SpaceClaim</strong></td>
<td>2017</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td><strong>Integrated Product Management Connections</strong></td>
<td>Unified Architecture 11.2.2 (2- &amp; 4-tier) with NX 11.0 only</td>
<td>√</td>
<td></td>
</tr>
<tr>
<td>Teamcenter 2</td>
<td>Unified Architecture 11.2 (2- &amp; 4-tier) with NX 10.0</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Unified Architecture 10.1.0.1 with NX 9.0</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

✓ = supported

1. applicable only to ANSYS DesignModeler
2. not supported with AIM
3. requires V5-6R2014, V6-6R2015, or V5-6R2016
4. requires Creo Parametric 3.0 M060 or later
5. requires Creo Parametric 2.0 M100 or later
6. requires CoCreate 19.0 M040
7. requires operating systems’ SP1
8. requires Creo Parametric 2.0 M190 or later
9. requires ST8 MP03

Project Schematic Presence Related to CAD Integration

The Project Schematic captures the project and workflow of your project, providing a visual representation of the objects in the project and their relationship to each other.

See CAD in Project Schematic for information about:

- Launching ANSYS Workbench from CAD Systems
- Material Processing
- CAD Configuration Manager

Project Schematic Presence topics:
- Geometry Preferences

Geometry Preferences

The following geometry preferences are accessible at the locations named below and vary in name depending on the location.

- **Workbench Options**: Accessible via Workbench> Tools> Options> Geometry Import to set the default values of the preferences. A checked box indicates “enable” or yes, an unchecked box indicates “disable” or no.

- **Workbench Project Schematic**: Right-click the Geometry cell and choose Properties.

- **Mechanical application**: Read-only indications of the settings are shown in the Details View of the Geometry object.

The preferences are displayed in two categories:

- **Basic Geometry Options** (p. 10)
- **Advanced Geometry Options** (p. 13)

DesignModeler and SpaceClaim Functionality

When DesignModeler or SpaceClaim are configured in add-in mode, most of the import preferences listed below are hidden. Except for the analysis-specific preferences, Analysis Type and Compare Parts on Update, all the applicable model data in the applications is transparently transferred,
### Basic Geometry Options

<table>
<thead>
<tr>
<th>Workbench Options &gt; Geometry Import Selections</th>
<th>Project Schematic Selections</th>
<th>Mechanical application's Geometry Object Details View Selections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Solid Bodies</strong> (check box)</td>
<td><strong>Solid Bodies</strong> (check box)</td>
<td><strong>Import Solid Bodies</strong></td>
<td>Imports solid bodies.(^{[1]}) The default is Yes. The preference applies to the following: All CAD Associative Geometry Interfaces and Readers.</td>
</tr>
<tr>
<td><strong>Surface Bodies</strong> (check box)</td>
<td><strong>Surface Bodies</strong> (check box)</td>
<td><strong>Import Surface Bodies</strong></td>
<td>Imports surface bodies.(^{[1]}) The default is Yes. The preference applies to the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ACIS Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AutoCAD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk Inventor Associative Geometry Interface and Reader (Merged/sewn work surfaces are not supported.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CATIA Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CATIA V5 Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Creo Elements/Direct Modeling</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Creo Parametric (formerly Pro/ENGINEER) Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GAMBIT Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IGES Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>JT (p. 74) Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NX Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Parasolid Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Solid Edge Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SolidWorks Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP Reader</td>
</tr>
<tr>
<td><strong>Line Bodies</strong> (check box)</td>
<td><strong>Line Bodies</strong> (check box)</td>
<td><strong>Import Line Bodies</strong></td>
<td>Imports line bodies. The default is No. The preference applies to the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ACIS Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>AutoCAD</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk Inventor Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CATIA V4 Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>CATIA V5 Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Creo Parametric Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>GAMBIT Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>IGES Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>JT (p. 74) Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>NX Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Parasolid Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Solid Edge Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>SolidWorks Associative Geometry Interface and Reader</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>STEP Reader</td>
</tr>
</tbody>
</table>

Note that only DesignModeler and ANSYS SpaceClaim Direct Modeler support cross-section definition/import.
<table>
<thead>
<tr>
<th>Workbench Options &gt; Geometry Import Selections</th>
<th>Project Schematic Selections</th>
<th>Mechanical application's Geometry Object Details View Selections</th>
<th>Description</th>
</tr>
</thead>
</table>
| Parameters (check box) | Parameters (check box) | Parameter Processing | Allows you to turn off parameter processing because it can take too long. The default is Yes. The preference applies to the following:  
  - Autodesk Inventor Associative Geometry Interface  
  - CATIA V5 Associative Geometry Interface  
  - Creo Parametric Associative Geometry Interface  
  - NX Associative Geometry Interface  
  - Solid Edge Associative Geometry Interface  
  - SolidWorks Associative Geometry Interface  
  (Displayed only when Parameter Processing is set to Yes in the Details View.)  
  Allows you to specify a key that must appear at the beginning or end of a CAD parameter name for the application to display as a CAD parameter in the interface. The default is ANS;DS. You can customize the parameter key supports multiple prefixes/suffixes values entered in the parameter key preference. Each of the values is to be separated by a semicolon. For example, if you wanted to support parameters that are keyed with DS and others that are keyed with PARAM you would enter DS;PARAM. The text field is case-insensitive, so entering ds;param would work just as effectively. There is no limit on the number of prefixes/suffixes that can be used in a single key preference. |
| Parameters > Filtering Prefixes and Suffixes (text field) | Parameter Key (text field) | Personal Parameter Key | Allows import of CAD system attributes into the ANSYS Mechanical models. Enable this option to import Motion Loads. The preference applies to the following:  
  - ACIS Reader  
  - Autodesk Inventor Associative Geometry Interface and Reader  
  - CATIA V4 Reader  
  - CATIA V5 Associative Geometry Interface and Reader  
  - Creo Parametric Associative Geometry Interface and Reader  
  - NX Associative Geometry Interface and Reader  
  - Solid Edge Associative Geometry Interface  
  - SolidWorks Associative Geometry Interface and Reader  
  This field can have any number of prefixes with each prefix delimited by a semicolon. By default the filter is set to DS;DDM. If the filter string all applicable entities will be imported as CAD system attributes. |
| CAD Attributes (check box) | Attributes (check box) | CAD Attribute Transfer | Creates a named selection based on data generated in the DesignModeler application. You must set the value in the Prefixes field (described below) to the desired value. Upon updating, a Named Selection branch is added to the tree and appears in the drop down display within the Named Selections maintained as a CAD named selection unless the branch is altered (entities added or deleted, selection renamed). After updating, CAD named selections are deleted and replaced with named selections that are... |
### Overview

<table>
<thead>
<tr>
<th>Workbench Options &gt; Geometry Import Selections</th>
<th>Project Schematic Selections</th>
<th>Mechanical application’s Geometry Object Details View Selections</th>
<th>Description</th>
</tr>
</thead>
</table>

updated model. The default is No. The preference applies to the following:

- ACIS Reader
- CATIA V4 Reader
- CATIA V5 Associative Geometry Interface and Reader
- Creo Elements/Direct Modeling
- Creo Parametric Associative Geometry Interface and Reader
- Autodesk Inventor Associative Geometry Interface and Reader
- NX Associative Geometry Interface and Reader
- Solid Edge Associative Geometry Interface
- SolidWorks Associative Geometry Interface and Reader

**Named Selections > Filtering Prefixes**

<table>
<thead>
<tr>
<th>Named Selection Key (text field)</th>
<th>Named Selection Prefixes</th>
</tr>
</thead>
</table>

(Displayed only when Named Selection Processing is set to Yes in the Details View.) Allows you to set the named selection processing prefix. The default is NS. This field can have any number of prefixes with each prefix delimited by a semicolon (for example: NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded). By default the filter is set to an empty string so that all applicable entities will be imported.

**Material Properties**

<table>
<thead>
<tr>
<th>Material Properties (check box)</th>
<th>Material Properties Transfer (check box)</th>
</tr>
</thead>
</table>

Allows import of material data defined in the CAD system. Material data will be imported. This will include Young’s Modulus, Poisson’s Ratio, Mass Density, Specific Heat, Thermal Conductivity and Thermal Expansion Coefficient. Limited additional data may be imported depending on CAD support. A material file will be created that reflects each material assigned to the model. You can validate the imported data of the material property values in Engineering Data. Choosing Update will allow you to import new materials but will not update values of previously imported materials. This is done to avoid overwriting user changes to previously imported material files. The default is No. The preference applies to the following:

- ACIS Reader
- Autodesk Inventor Reader
- Autodesk Inventor Associative Geometry Interface
- CATIA V5 Reader
- CATIA V5 Associative Geometry Interface
- Creo Parametric Reader
- Creo Parametric Associative Geometry Interface
- NX Reader
- NX Associative Geometry Interface
- Solid Edge Reader
- Solid Edge Associative Geometry Interface (*.par, *.asm, *.psm, *.pwd)
- SolidWorks Reader
- SolidWorks Associative Geometry Interface

[1] These preferences are on a per part basis. Parts with solid bodies and surface bodies will result in an attach failure if both import type preferences are selected. For assemblies however, where different components are solely solid body or surface body, import of each part will be successful.
[2] Limitations on importing named selections:

- If you use a CAD system filter for entities, you must be able to create entities with names that correspond to the filter.

- Named selection sets should contain entities of only a single dimension (for example, faces, edges).

- Refer to the Named Selection Import based on Entities (p. 23) table to determine the CAD system support for the various entities (vertex, edge, face, body).

**Advanced Geometry Options**

<table>
<thead>
<tr>
<th>Workbench Options&gt; Geometry Import &gt; Project Schematic Selections</th>
<th>Mechanical application's Geometry Object Details View &gt; Selections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type (drop down menu)</td>
<td>Analysis Type (drop down menu)</td>
<td>Analysis Type</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• On Project Schematic, sets the geometry for a 2-D simulation or a 3-D simulation.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In Options dialog box, sets default for the Project Schematic setting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In Details View, a read only indication of the current analysis type.</td>
</tr>
</tbody>
</table>

The preference applies to all supported CAD systems and to the DesignModeler application.

<table>
<thead>
<tr>
<th>CAD Associativity (check box)</th>
<th>Use Associativity (check box)</th>
<th>CAD Associativity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Indicates if action should be taken to allow associativity. This option is present because some CAD systems take too long to compute associativity. The default is <strong>Yes</strong>. The preference applies to the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Autodesk Inventor</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>CATIA V5</strong></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Creo Elements/Direct Modeling</strong></td>
</tr>
<tr>
<td>Workbench Options</td>
<td>Project Schematic Selections</td>
<td>Mechanical application's Geometry Object Details View Selections</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Geometry Import Selections</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Coordinate Systems (check box)</td>
<td>Import Coordinate Systems (check box)</td>
<td>Import Coordinate Systems</td>
</tr>
<tr>
<td>Workbench Options &gt; Geometry Import Selections</td>
<td>Project Schematic Selections</td>
<td>Mechanical application's Geometry Object Details View Selections</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>-----------------------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Import Work Points</strong> (check box)</td>
<td><strong>Import Work Points</strong> (check box)</td>
<td><strong>Reader Save Part File</strong> (check box) <strong>Reader mode saves updated file</strong> (check box)</td>
</tr>
<tr>
<td><strong>Import Using Instances</strong> (check box)</td>
<td><strong>Import Using Instances</strong> (check box)</td>
<td><strong>Import Using Instances</strong> (check box)</td>
</tr>
<tr>
<td>Workbench Options</td>
<td>Project Schematic Selections</td>
<td>Mechanical application's Geometry Object Details View Selections</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td>Geometry Import Selections</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Smart Update</strong> (check box)</td>
<td><strong>Smart CAD Update</strong> (check box)</td>
<td><strong>Do Smart Update</strong></td>
</tr>
</tbody>
</table>

For more information, see **Do Smart Update** in the ANSYS DesignModeler application help, or the ANSYS Mechanical application Help. Note that line bodies are not supported with Smart CAD Update and are always marked unmeshed. Any part which has been moved or an instance (p. 123) of it has been moved
<table>
<thead>
<tr>
<th>Workbench Options</th>
<th>Project Schematic Selections</th>
<th>Mechanical application’s Geometry Object Details View Selections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Compare Parts On Update (drop-down)</td>
<td>Compare Parts on Update</td>
<td>Compare Parts on Update</td>
<td>since last imported will not be refreshed through the Smart Update process. Such parts will always be unmeshed following update.</td>
</tr>
<tr>
<td>Compare Parts Tolerance (drop-down)</td>
<td>Compare Parts Tolerance (drop-down)</td>
<td>Compare Parts Tolerance</td>
<td>For more information, See Compare Parts on Update (p. 20) in the CAD Integration help.</td>
</tr>
</tbody>
</table>

Use to set the tolerance. The choices are Loose, Normal, and Tight (default). The preference is only displayed in the Properties panel if the compare parts have a value to compare. Note that although the choices are the same, the **Compare Parts Tolerance** and **Model Tolerance** in DesignModeler are unrelated.

- **Tight**: The Tight setting identifies updated geometry with only very small deviations as unchanged.
- **Normal**: The Normal setting allows a 100 times greater deviation than tight.
- **Loose**: The Loose setting is 100 times greater than normal.

These deviations are intended to account for modest internal deviations that can sometimes be generated in
<table>
<thead>
<tr>
<th>Workbench Options&gt; Geometry Import Selections</th>
<th>Project Schematic Selections</th>
<th>Mechanical application’s Geometry Object Details View Selections</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>computational values or in the mathematical representation of some geometry. It is not intended to hide true geometric modifications.</td>
</tr>
<tr>
<td>Process Enclosures (check box)</td>
<td>Enclosure and Symmetry Processing (check box)</td>
<td>Enclosure and Symmetry Processing</td>
<td>Use to turn on/off the processing of enclosure and symmetry named selections. The default is Yes. The preference applies to the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>DesignModeler</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry (check box)</td>
<td>Decompose Disjoint Geometry (check box)</td>
<td>Decompose Disjoint Geometry</td>
<td>The preference applies to the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Creo Parametric</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Associative Geometry Interface (for use with faces only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Autodesk Inventor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Associative Geometry Interface (for use with bodies only)</td>
</tr>
<tr>
<td>Mixed Import Resolution (drop-down)</td>
<td>Mixed Import Resolution (drop-down)</td>
<td>Mixed Import Resolution</td>
<td>Allows parts of mixed dimension to be imported as components of assemblies which have parts of different dimension. The options are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>None</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Solid</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Surface</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Solid and Surface</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Surface and Line</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The default is None which means that if there are bodies of mixed dimension in a multibody part, nothing</td>
</tr>
</tbody>
</table>
Mechanical application's Geometry Object Details View Selections

**Workbench Options**

Geometry Import Selections

**Project Schematic Selections**

**Mechanical application's Geometry Object Details View Selections**

is transferred to the ANSYS Mechanical application. **Solid** means only solid(s) from the part are transferred to the ANSYS Mechanical application. **Surface** means only surface(s) from the part are transferred to the ANSYS Mechanical application. **Line** means only line(s) from the part are transferred to the ANSYS Mechanical application. **Solid and Surface** means only solid(s) and surface(s) from the part are transferred to the ANSYS Mechanical application. **Surface and Line** means only surface(s) and line(s) from the part are transferred to the ANSYS Mechanical application. This option is controlled by the feature in DesignModeler.

**Expected Body Imports**

The following table shows the expected body imports based on the composition of the part (top row) and the mixed dimension import resolution preference. It is assumed for this table that the body types indicated in the part are selected in the primary import options.

<table>
<thead>
<tr>
<th>Solid-Surface-Line</th>
<th>Solid-Surface</th>
<th>Solid-Line</th>
<th>Surface-Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>No import</td>
<td>No import</td>
<td>No import</td>
</tr>
<tr>
<td>Solid</td>
<td>Solid</td>
<td>Solid</td>
<td>No import</td>
</tr>
<tr>
<td>Surface</td>
<td>Surface</td>
<td>Surface</td>
<td>Surface</td>
</tr>
<tr>
<td>Line</td>
<td>Line</td>
<td>No import</td>
<td>Line</td>
</tr>
<tr>
<td>Solid and Surface</td>
<td>Solid and Surface</td>
<td>Solid and Surface</td>
<td>Surface</td>
</tr>
<tr>
<td>Surface and Line</td>
<td>Surface and Line</td>
<td>Surface</td>
<td>Line</td>
</tr>
</tbody>
</table>

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
This processing becomes significant after handling the basic import options (e.g. if a part is Solid-Surface-Line, if only Import Solids is selected, then only solid bodies would be imported) regardless of the Mixed Import Resolution (p. 21).

However, when transferring the model from the ANSYS DesignModeler or SpaceClaim application to the ANSYS Mechanical application for a 3D Analysis, the basic import options and Mixed Import Resolution (p. 21) option are not applicable. All unsuppressed bodies/parts in the model will be transferred to the ANSYS Mechanical application.

**Note**

In the case of a 2D analysis, you should suppress all solid bodies in DesignModeler for a successful transfer.

*Post-Import Script*

A script that will be executed after the completion of the attach of an active geometry when using the Workbench button in the ANSYS menu inside the CAD system. This extensible functionality allows you to create and import into a specified system, set geometry import preferences for the import and execute other scriptable functionality. Simple example scripts can be found in ANSYS_InstallDir\aisol\Common-Files\CommonPages\PostImportScripts.

**Compare Parts on Update**

*Compare Parts on Update* is a Geometry Import option, available inside ANSYS Workbench. The ANSYS Mechanical editor and ANSYS Meshing make use of the benefits of the preference.

The option compares the existing geometry and updated-to geometry to determine if any bodies/parts remain unmodified. When you choose the Refresh Geometry context menu option (right-click on the Geometry tree object or anywhere in the Geometry window), if no changes to the body are detected (found to be unmodified), then the body/part does not need to be remeshed after the update has occurred.

The option can be set or modified before any update in the ANSYS Mechanical editor or ANSYS Meshing and the subsequent updates will utilize that option.

For more information, see Compare Parts on Update in the Advanced Geometry Options table at Geometry Preferences in the CAD Integration section of the ANSYS Help.

**Note**

The Non-Associative setting for Compare Parts on Update depends on the entities from the updated model being in the same order as the original model. If that order changes at any level, that part will be marked as modified. For most CAD systems if the CAD session remains open the order is more likely maintained then if the CAD is shut down and the model reopened. For those geometry imports that support associativity the associative option for Compare Parts on Update is the preferred mechanism.

The Compare Parts on Update feature is not supported for line bodies.
If the final existing instance of a part is modified such that it is no longer instanced, an associative
Compare Parts on Update may result in both the un-modified and the modified part being marked
as un-meshed, due to a change in the transformation matrix of the un-modified part.

**Accessibility**

From the **Tools** menu in ANSYS Workbench, select **Options** to display a dialog box and then, select
**Geometry Import**. The **Advanced Options** category includes the **Compare Parts on Update** option.

- The choices are:
  - **No** (default): No post-update comparison will be attempted and all bodies/parts included in the update
    will be marked as dirty and needing remeshed.
  - **Associatively**: Searches through the part data to find appropriately matching entities for comparison
    based on their associative data. This option is slower because of that search but provides the best
    option if parts or bodies are reorganized or added to or deleted from. The **Associatively** option is
    the recommended comparison option and should be used exclusively if the model utilizes merged
    topology from the DesignModeler application.
  - **Non-Associatively**: Generates a faster comparison but only does comparison on entities of a corres-
    ponding index (body 1 original -> body 1 updated). If bodies are not reorganized or added to or
    deleted from this method should be adequate, as long as the original topology is preserved. You
    should not use the **Non-Associatively** option when using merged topology options (Automatic or
    Imprints) from the DesignModeler application.

The three options for Tolerance are:

- **Tight** (default): the Tight setting identifies updates geometry with only very small deviations as unchanged.
- **Normal**: the Normal setting allows a 100 times greater deviation than tight.
- **Loose**: the Loose setting is 100 times greater than normal.

These deviations are intended to account for modest internal deviations that can sometimes be generated
in computational values or in the mathematical representation of some geometry. It is not intended to
hide true geometric modifications.

**Mixed Import Resolution**

Mixed-dimension parts are parts that contain bodies of differing dimension (solids and surfaces, surfaces
and lines, solids and lines, or solids, surfaces, and lines). When importing mixed-dimension parts, the
Mixed Import Resolution preference controls which dimensional sets of these bodies are imported. For
example, if the part contains solids, surfaces, and lines and the Mixed Import Resolution preference is
set to Surface, only the surface bodies contained in the part will be imported. The option has no effect
on the import of single-dimension parts.

For more information about Mixed Import Resolution, see the tables in **Geometry Preferences** (p. 9).

**Basic Options:** Basic Geometry Options (p. 10)
**Advanced Options:** Advanced Geometry Options (p. 13)
**CAD Configuration Manager**

The CAD Configuration Manager allows you to configure geometry interfaces for:

- Mechanical APDL (ANSYS)
- ANSYS Workbench

CAD configuration is typically handled during the product installation; however, if you chose to skip those steps, or if you make changes to your local CAD configuration between releases (for example, you install, move, or update your CAD package, or remove it entirely), you can use this utility.

For platform specific information to use the CAD Configuration Manager, see:

- ANSYS, Inc. Windows Installation Guide> Configuring CAD Products> Using the CAD Configuration Manager
- ANSYS, Inc. Linux Installation Guide> Configuring CAD Products> Using the CAD Configuration Manager on Linux

Topics covered include:

- Unconfiguring
- Running the CAD Configuration Manager in Batch Mode
- Uninstalling
- Creo Parametric Configuration
- NX Configuration
- Configuring CADNexus/CAPRI CAE Gateway for CATIA V5

**Notations**

If the help for the CAD Configuration Manager does not load into your default browser, set the BROWSER environment variable to the path of your HTML viewer (such as Mozilla or Firefox) and restart the CAD Configuration Manager.

**Named Selection Manager**

Use the **ANSYS Named Selection Manager** to create custom attributes with CAD systems for modeling, meshing and performing analysis within ANSYS Workbench.

This mechanism is activated by selecting the **Named Selection Manager** menu item from the current ANSYS release menu inside the CAD system (with the exception of Creo Elements/Direct Modeling and CATIA).
The Named Selection Manager displays groups created only in this tool but the Plug-in (p. 123) will continue to support those previously imported in earlier ANSYS releases. The Named Selections are always listed alphabetically. The Named Selection Manager supports defining Name Selection Groups within CAD through the following operations.

- **Create**: Pre-select entities to designate for the NS Group, click on “Create” button and designate a name for the group. Some CAD systems (e.g. Solid Edge and NX) allow the selection between the Create and Naming operations.

- **Delete**: Select a group from the Named Selection Manager list followed by clicking the “Delete” button. The Delete option allows you to delete the chosen named selection. Note that a confirmation dialog box does not appear before that deletion.

- **Rename**: Select an entry from the Named Selection Manager group list, click on the “Rename” and supply a new group name. The Rename option allows you to change the name of the selected group.

- **Replace**: Pre-select entities to compose the Named Selection, click on “Replace”. The newly selected set will replace the entities in the Named Selections. No previous entities will remain except those which were selected at the time of the “Replace” operation.

- **Select/Deselect**: Help tools which allow for verification of a Named Selection Group’s contents.

- **Close**: Closes the existing Named Selection Manager dialog.

- **Help**: Opens ANSYS Workbench help.

Note that in the case of NX, the geometry selection dialog box will prompt you when to click the Select option. To modify a named selection, select the entry in the list and click the Replace option. The geometry selection dialog box will pop up again to let you modify the selection created earlier.

### Named Selection Import based on Entities

A check mark represents entities that are supported by the CAD system in the first column.

<table>
<thead>
<tr>
<th>CAD System</th>
<th>Vertex</th>
<th>Edge</th>
<th>Face</th>
<th>Body</th>
</tr>
</thead>
<tbody>
<tr>
<td>Autodesk Inventor</td>
<td>Part Level</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
<tr>
<td></td>
<td>Assembly Level</td>
<td>√</td>
<td>√</td>
<td>√</td>
</tr>
</tbody>
</table>
GUI Navigation: Creating Named Selections in CAD System to Import into Workbench

To create named selections within a CAD system for importation into ANSYS Workbench:

1. From an active CAD session, select the element (e.g. faces) of the model to which you want to apply a named selection to the **Named Selection Manager**.

2. Select **Named Selection Manager** from the ANSYS drop down menu to display a dialog box.

3. Select Create to display a second dialog box (Name Input Dialog).

4. Enter a name for the selected element. Select OK to list the name in the ANSYS Named Selection dialog box.

5. Highlight the Named Selection to activate the Select, Replace, Rename, and Delete options in the dialog box. Choose an option, and select Close.

6. Import the active model into the desired application making sure to set the Named Selections preference on and the Named Selections Key matching the desired sets for import.

7. Select Workbench from the ANSYS drop down menu to start an ANSYS Workbench session.

8. The CAD system icon in the Geometry cell of the Project Schematic indicates the model is loaded. Right-click the Geometry cell to select Edit, or double-click cell.

9. Choose desired length in the Units dialog box, and select OK. An object named “Attach1” appears in the tree outline.

10. In the **Details View**, select Yes to Import Named Selections.

11. In the **Details View**, the Named Selection Key must match the CAD system prefix.

12. Select Generate on the 3D features toolbar to complete the Attach feature. The Named Selection created in the CAD system appears under the “Attach1” object in the tree outline.
Caveats and Known Issues

Geometry Import Fails  ANSYS Workbench leverages a running CAD session to update models if one exists. If you change the geometry source to a file that cannot be opened in the running session, the update will fail with an unable to activate document error. Some reasons this may occur are if the new model is from a version of the CAD system later than the one running or if another file of the same name is already opened in the CAD from another directory.

Length Units When Changing Geometry Sources  The length units of loads and boundary conditions are based on the unit of the imported model in Mechanical. When the source geometry is changed to another model which uses a different length unit than the first, then loads, boundary conditions, and non-associative coordinate systems in Mechanical will scale to match the new length unit of the imported geometry. This may be observed when importing a model into Mechanical, then later choosing to edit the geometry in DesignModeler. If the DesignModeler session’s length unit is different than the original CAD model’s length unit, then any existing loads or boundary conditions in Mechanical that were defined for the original CAD model may get scaled.
CAD Integration Installation and Licensing

Because the individual CAD systems are listed with the other components during the product installation, you can select the CAD interfaces that you wish to install.

Some product components, including some CAD interfaces, require administrative permissions to register. If you install with non-administrative privileges, you must follow the post-installation procedures as an administrator for your product to ensure that all components are successfully registered.

For CAD-related installation prerequisites, see Table 1–3 (Product Support) in the following sections:

- Installation Prerequisites for Windows
- Installation Prerequisites for Linux

For CAD-related installation information, see:

- ANSYS, Inc. Windows Installation Guide> Configuring CAD Products
- ANSYS, Inc. Linux Installation Guide> Configuring CAD Products

For licensing information, see the Product Variable Table in the ANSYS Licensing Guide.
CAD Integration AIM Interoperability

ANSYS AIM is a single, end-to-end multiphysics solution for simulation. Geometry can be imported from a CAD system to begin an analysis, or ANSYS AIM can be launched from specific supported CAD systems. The supported systems include:

- AutoCAD (*.dwg, *.dx) (p. 34)
- Autodesk Inventor (*.ipt, *.iam) (p. 38)
- Creo Parametric (*.prt, *.asm) (p. 56)
- NX (*.prt) (p. 77)
- Solid Edge (*.par, *.asm, *.psm, *.pwd) (p. 88)
- SolidWorks (*.sldprt, *.sldasm) (p. 94)
- SpaceClaim (*.scdoc) (p. 99)

Launching from a CAD System

The CAD system must be configured for Plug-In mode to launch ANSYS AIM. To launch ANSYS AIM from any of the CAD systems:

- open a geometry model in the CAD system, and
- select the AIM button, located in either the ribbon menu or drop-down menu depending on the CAD system.

AIM is launched with the model loaded in the Geometry cell, and marked as “out of state” until updated.

AIM Help

ANSYS AIM Help is viewable via the ANSYS Help Viewer.
CAD Integration File Format Support

Within ANSYS Workbench, the CAD files can be attached in either Plug-In or Reader mode.

- **Plug-In mode**: requires that the CAD system be running.
- **Reader mode**: does not require the CAD system to be running.
- **Pseudo-Reader mode**: CAD system is started by ANSYS Workbench in batch mode and shuts it down after attach/update is completed.

File Format Supported:

- ACIS (*.sat, *.sab) (p. 32)
- ANSYS Part Manager (*.pmdb) (p. 34)
- AutoCAD (*.dwg, *.dxf) (p. 34)
- Autodesk Inventor (*.ipt, *.iam) (p. 38)
- CATIA (*.model, *.exp, *.session, *.CATPart, *.CATProduct) (p. 43)
- **CoCreate Modeling**: see Creo Elements/Direct Modeling
- Creo Parametric (*.prt, *.asm) (p. 56)
- ANSYS DesignModeler (.agdb) (p. 66)
- GAMBIT (*.dbs) (p. 70)
- IGES (*.igs, *.iges) (p. 72)
- JT Reader (*.jt) (p. 74)
- Monte Carlo N-Particle (*.mcnp) (p. 76)
- NX (*.prt) (p. 77)
- **OneSpace Designer Modeling**: see Creo Elements/Direct Modeling
- Parasolid (*.x_t, *.xmt_txt, *.x_b, *.xmt_bin) (p. 83)
- **Pro/ENGINEER**: see Creo Parametric
- Rhinoceros (*.3dm) (p. 85)
- SketchUp (*.skp) (p. 87)
- Solid Edge (*.par, *.asm, *.psm, *.pwd) (p. 88)
File Format Support

- SolidWorks (*.sldprt, *.sldasm) (p. 94)
- SpaceClaim (*.scdoc) (p. 99)
- STEP (*.stp, *.step) (p. 100)

**ACIS (*.sat, *.sab)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the ACIS system be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface is configured during ANSYS installation by default.

See **CAD Configuration Manager (p. 22)** for usage information.

For detailed installation information about the CAD Configuration Manager, see:

Linux: Configuring CAD Products> Using the CAD Configuration Manager
Windows: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via **Geometry Interface Support (p. 3)**.

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See **ANSYS Platform Support**.

**Document import supported by interface:** Part (*.sat, *.sab)

**Versions:** R1 — 2017

**Table 1: Import Preference Support for ACIS geometry interface**

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color, Layer, and Publication</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color, Layer, and Publication</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes- Only surface bodies in the xy plane will be imported</td>
</tr>
</tbody>
</table>

Support

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via **Geometry Interface Support (p. 3)**.

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See **ANSYS Platform Support**.

**Document import supported by interface:** Part (*.sat, *.sab)

**Versions:** R1 — 2017

**Table 1: Import Preference Support for ACIS geometry interface**

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color, Layer, and Publication</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color, Layer, and Publication</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes- Only surface bodies in the xy plane will be imported</td>
</tr>
</tbody>
</table>
**Notations**

**Selective Update**  This interface fully supports the Selective Update feature.

**Length Unit**  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit filed in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Assembly**  Although the ACIS geometry format does not have an assembly entity, the application supports ACIS files containing one or multiple bodies.

**Hidden Parts**  Parts that are hidden or suppressed in ACIS are skipped automatically by this interface.

**Import CAD Color as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Import CAD Layer as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3")

**Import CAD Publication as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Publication" or any number of prefixes with each prefix delimited by a semicolon (for example: "NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Publication" or any number of prefixes with each prefix delimited by a semicolon (for example: "NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded").
Caveats and Known Issues

No caveats or known issues.

Troubleshooting

See the ACIS Errors Related to CAD Integration (p. 120) section in CAD Integration Troubleshooting (p. 119) for detailed information.

ANSYS Part Manager (*.pmdb)

Notations

Import Preferences  When importing ANSYS Part Manager files, import preferences will not be shown. This is because these files are essentially a snapshot of a prior import. They will simply resume the geometry data exactly as it was originally imported.

AutoCAD (*.dwg, *.dxf)

For more information, see:
  AutoCAD Reader (*.dwg, *.dxf)
  AutoCAD Associative Geometry Interface (*.dwg, *.dxf)

AutoCAD Reader (*.dwg, *.dxf)

The interface works in a Reader (p. 123) mode.

• This is a stand-alone reader which does not require that the AutoCAD system be installed.

• No CAD associativity support.

• No CAD Parameter support.

The interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

  Windows: Configuring CAD Products> Using the CAD Configuration Manager

Support

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Document import supported by interface: *.dwg, *.dxf
**Versions:** 2.5 - 2016

**Table 2: Import Preference Support for interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Preference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes - Only surface bodies in the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Notations**

**Selective Update**  This interface fully supports the Selective Update feature.

**Length Unit**  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Hidden Parts**  Parts that are hidden or suppressed in AutoCAD are skipped automatically by this interface.

**Import CAD Color as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Import CAD Layer as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").
• **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3")

**Caveats and Known Issues**

The AutoCAD Reader has the following limitations:

- No AEC and AECB entries.
- No support for paper spaces.
- No support for block properties (Color, Layer).
- No support for Insert Layer Mode color handling.
- No support for PMI & Text.
- No support for Body names.

**Troubleshooting**

See [CAD Integration Troubleshooting](p. 119) for detailed information.

**AutoCAD Associative Geometry Interface (\*.dwg, \*.dx f)**

The interface works in both Plug-in (p. 123) and Pseudo-Reader (p. 123) mode.

See the [CAD Configuration Manager](p. 22) for usage information.

- **Linux**: Configuring CAD Products> Using the CAD Configuration Manager
- **Windows**: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via [Geometry Interface Support](p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See [ANSYS Platform Support](#).

**Document import supported by interface**: \*.dwg, \*.dx f

Table 3: Import Preference Support for interface

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes – AutoCAD Layers can be imported as Named Selections</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>Yes: for parts that include more than one body type (solid, surface, line) with these selected for import.</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note**

AutoCAD LT is not supported; you must have the full version of the product to perform an import.

**Notations**

Entities which belong to layers which are invisible, frozen or turned off will be skipped during import.

AutoCAD mesh bodies, of type Polygon Mesh and Polyface Mesh, are not supported for import. Note that when exporting Revit models to DWG the default solid type is Polyface. To generate a DWG file with Workbench importable bodies, it is required that the Revit user select "ACIS Solids" in the Solids tab of the DWG/DFX Export Setup dialog.

**Body Arrays**  Geometry created by using the AutoCAD "Array" command will not automatically be imported into ANSYS Workbench. To make such bodies importable: (a) load the drawing file into AutoCAD, (b) select the array, and (c) issue the "Explode" command.

**Color Processing**  AutoCAD bodies can be automatically grouped in Named Selections based upon their color by adding the keyword "Color" to the Named Selection Key list. The resultant selection groups will be named with the form, Color:R.G.B. Here R, G and B are values ranging from 0 to 255, which represent the amount of color saturation of Red, Green and Blue color components. For example Color:0.0.0 is black, Color:255.255.255 is white, and Color:255.0.0 is red.

Within the Mechanical application, body colors can be visually altered to match what is displayed in the AutoCAD session by executing the following steps:

1. Prior to attach/refresh, enable the Attributes preference.

2. Add the keyword "Color" to the Attributes Key list.

3. After attach/refresh is complete, within Mechanical perform Tools->Run Macro and designate this script to be run: `<install dir>/v<version>/aisol\DesignSpace\DSPages\macros\BodyColorByCADColorAttribute.js`

**Layer Processing**  AutoCAD entities can be automatically assigned to Named Selections based upon their layer assignment. This can be accomplished by enabling the Named Selection preference, and
adding the keyword "Layer" to the Named Selection Key list. Subsequent attach/refresh actions will import with selection groups named with the form, Layer:<AutoCAD Layer Name>.

**Localization Considerations** To change the ANSYS Ribbon to match Workbench localization follow these steps:

1. Unconfigure the AutoCAD Plug-In using CAD Configuration Manager
2. Run AutoCAD one time, then close.
3. Under the options menu, change locale setting within Workbench.
4. Configure the AutoCAD Plug-In using CAD Configuration Manager.
5. Run AutoCAD.

**Pseudo-Reader Attach/Refresh** When importing and no active session of AutoCAD is running, ANSYS Workbench will automatically launch the last run version of AutoCAD for the current user account. Import will fail if the current user has never launched AutoCAD. In this case launching the CAD system one time will resolve the failure.

**Units** AutoCAD does maintain an internal length unit scale factor. However, by default the length unit is undefined for all layouts Block Table Records such as Model Space and Paper Space. This conflicts with the model unit specification within the drawing file. To reconcile the potential discrepancy the geometry interface will interpret AutoCAD models as if they have the same length unit system specified within ANSYS Workbench, with no conversion attempted.

**Autodesk Inventor (*.ipt, *.iam)**

For more information, see:
- Autodesk Inventor Reader (*.ipt, *.iam)
- Autodesk Inventor Associative Geometry Interface (*.ipt, *.iam)

**Autodesk Inventor Reader (*.ipt, *.iam)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the Autodesk Inventor system be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager. See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Windows**: Configuring CAD Products > Using the CAD Configuration Manager
Support

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Document import supported by interface: Part (*.ipt) and Assembly (*.iam)

Versions: .ipt (6 — 2017), .iam (11 — 2017)

Table 4: Import Preference Support for interface

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>No</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes – Color</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes – Color</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes 2D - Yes- Only surface bodies in the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Notations

Selective Update This interface fully supports the Selective Update feature.

Length Unit The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

Hidden Parts Parts that are hidden or suppressed in Autodesk Inventor are skipped automatically by this interface.

Import CAD Color as an Attribute or Named Selection
**Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Caveats and Known Issues**

The Inventor Reader has the following limitations:

**Limited support for Inventor Assembly.**

- Assembly attributes such as colors and layers are not supported.

- Assembly level features are not supported. For example, an instance can be marked as suppressed (that is, not visible) in an Inventor assembly. Because the reader does not support reading suppressed information, suppressed instances are translated.

**No Support for Sketches.** The reader currently does not support sketches from Inventor files.

**Limited Entity Support for Inventor.** The reader currently does not support some specific entities resulting from advanced feature Inventor operations such as Lofting.

**No Support for Layers.** The reader does not support translating layer information.

**No Support for Welding Symbols.** The reader does not support Weld symbols from Inventor Files.

**BREP Color Limitation.** Body colors are not supported for parts having multiple bodies with the same number of faces. No color support for files created in a local, non-English Inventor Modeler.

**Material Properties Limitation.**

- Only isotopic material properties and metric standard units (MPa, Kg, J) are supported.

- The reader translates material properties for Inventor version 2012 and later. Only isotropic material properties and metric standard units (MPa, Kg, J) are supported. Currently material properties for default Inventor material (that is, "Generic" shown in Inventor Modeler) are not supported.

**No Support for Free Form Surface.** The translator does not support Free Form Surface (T-Splines).

**Troubleshooting**

No known issues have been identified in the CAD Integration Troubleshooting (p. 119) section.

**Autodesk Inventor Associative Geometry Interface (*.ipt, *.iam)**

The interface works in both a Plug-in (p. 123) and a Pseudo-Reader (p. 123) mode.

The existence of the Plug-in (p. 123) is recognized by Autodesk Inventor based on registry entries. If the Plug-in (p. 123) is not available in the add-in manager in Autodesk Inventor you will need to run the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:
Windows: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Table 5: Import Preference Support for Autodesk Inventor geometry interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solids</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>No</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - including Color</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - including Color</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Surface bodies in only the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes - part and assembly user coordinate systems</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes</td>
</tr>
<tr>
<td>Smart Update</td>
<td>Yes</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>Yes - for parts that include both Solid and surface bodies AND the Import Solid and Import Surface preferences are set to Yes</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes (for use with bodies only)</td>
</tr>
</tbody>
</table>

**Notations**

The Autodesk Inventor geometry interface also supports the Selective Update feature.

Assembly parts and sub-assemblies that are hidden, suppressed or disabled in Autodesk Inventor are automatically excluded from import.

ANSYS Workbench automatically locks the length unit in the part or assembly to centimeters, which is the unit used internally by Autodesk Inventor. No adjustment of length unit is necessary or possible. The ANSYS Mechanical application user can change the unit system for display of the ANSYS Mechanical application data.
Specific to ANSYS DesignModeler

To successfully import parts into the ANSYS DesignModeler application, you may need to suppress the elliptical features from the tree in Autodesk Inventor.

Large models (up to 499999m from the origin in any direction) created in Autodesk Inventor can be imported to the DesignModeler application. Note that the DesignModeler application reports the bounding box of 500 km for such entities; i.e. the tolerance for Autodesk Inventor is 1 m.

Autodesk indicates that Shrinkwrap of Inventor native assemblies can produce non manifold bodies. In this case the Inventor body can display normally in the CAD’s model tree, but is not expected to import cleanly into DesignModeler due to gaps where small faces were removed.

Bodies imported into Inventor from external sources can produce non-manifold solids, which load into DesignModeler with less than okay status and missing faces. Right clicking on these bodies within Inventor will provide access to the Body Repair tools offered within the CAD. These utilities can be used to identify and heal errors in the Inventor geometry, which in turn can improve translation into DesignModeler.

When transferring geometry from Autodesk Inventor to the Workbench using the associative geometry interface, a specific representation is not loaded into Autodesk Inventor when opening a document via Pseudo-Reader (p. 123) mode. If a specific representation is required, it should be explicitly set in an active Autodesk Inventor session prior to attach.

Caveats and Known Issues

DSPlugInAICOM Add-in  The first time you start Inventor after installing/configuring the plug-in you may be presented with a dialog box asking whether you would like to load the DSPlugInAICOM add-in. Here if you click Allow the Associative Interface will automatically load in the future without the message box appearing again.

Decompose Disjoint Geometry  Each component shell will be imported as a distinct body. Decomposition is only supported for solid bodies, and disjoint surface bodies such as face patches and work surfaces will not be broken apart.

Import and Mesh Efficiency  To improve import and mesh efficiency the import or part instancing is supported. As a result, a break in associativity is expected when performing an update for models from versions of Workbench earlier than 16.0. The work-around is to disable the Instancing preference prior to refreshing the geometry from CAD, with the downside of losing out on the performance improvements yielded via Instancing.

Named Selections Restrictions  The Autodesk Inventor Plug-in (p. 123) does not support the creation of Named Selections beginning with numeric characters, containing spaces, the slash (/) or backslash (\) characters.

Plug-In Availability Considerations  Due to the architecture of the CAD’s Add-In manager, the Autodesk Inventor geometry interface will automatically load into the Inventor sessions of all users when any administrative user has configured the geometry interface only to be available for their account. This is the case even when the user has not configured the geometry interface for himself/herself and a global configuration has not been performed to enable the plug-in to run for all users. When encountering such a state it may be possible to import geometry from an active Inventor session, but any attempts to attach or refresh geometry without Inventor running will fail.
Reference Key  If, upon attaching, you receive the message *Failed to get reference key*, the attaching process will continue, but an associative relation during update cannot be guaranteed.

Troubleshooting

See the Autodesk Inventor Errors Related to CAD Integration (p. 121) section in CAD Integration Troubleshooting (p. 119) for detailed information.

**CATIA (*.model, *.exp, *.session, *.CATPart, *.CATProduct)**

For more information, see:
- CATIA V4 Reader (*.model, *.exp, *.session)
- CATIA V5 Reader (*.CATPart, *.CATProduct)
- CATIA V5 Associative Geometry Interface (*.CATPart, *.CATProduct)
- CATIA V6 Reader (*.3dxml)

**CATIA V4 Reader (*.model, *.exp, *.session)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone Reader (p. 123) which does not require that the CATIA V4 system be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager. See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

**Windows:** Configuring CAD Products> Using the CAD Configuration Manager

Support

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** Part (*.model, *.exp, *.session)

**Versions:** 4.1.9 — 4.2.4

**Table 6: Import Preference Support for interface**

<table>
<thead>
<tr>
<th>Import</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>----</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
</tbody>
</table>
| Analysis Type                            | 3D - Yes  
2D - Yes- Only surface bodies in the xy plane will be imported |
| Associativity                            | No |
| Coordinate Systems                       | Yes |
| Work Points                              | Yes |
| Reader Save File                         | No |
| Instancing                               | No |
| Smart Update                             | No |
| Enclosure and Symmetry Processing        | No |
| Mixed Import Resolution                  | No |
| Decompose Disjoint Geometry              | Yes |

**Notations**

**Selective Update**  This interface fully supports the Selective Update feature.

**Length Unit**  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Hidden parts**  Parts that are hidden or suppressed in CATIA are skipped automatically by the geometry interface.

**Import CAD Color as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Import CAD Layer as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3")

**Caveats and Known Issues**

The CATIA V4 Reader has the following limitations:
Unsupported CATIA file formats  Does not provide the functionality to read CATIA assembly (*.asm) and CATIA drawing files (*.drw).

Model history information  Does not provide the functionality to read the modeling history maintained in CATIA.

VIEW or DITTO layers  A layer belonging to VIEW or DITTO is not read. The layer filters for VIEW and DITTO are different and are not supported. The layer 255 is meant only for DITTO, which is not supported.

Troubleshooting

See the CATIA Errors Related to CAD Integration (p. 121) section in CAD Integration Troubleshooting (p. 119) for detailed information.

CATIA V5 Reader (*.CATPart, *.CATProduct)

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the CATIA V5 system be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

Windows: Configuring CAD Products> Using the CAD Configuration Manager
Linux: Configuring CAD Products> Using the CAD Configuration Manager

Support

At the time of release, detailed version support information for the Windows (p. 7) and Linux (p. 5) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Document import supported by interface: Part (*.CATPart) and Assembly (*.CATProduct)

Versions: V5R8 – V5–6R2017(Windows) and V5R10 – V5–6R2017 (Linux)

Table 7: Import Preference Support for interface

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color, Layer, and Publication (Windows)</td>
</tr>
</tbody>
</table>
### File Format Support

<table>
<thead>
<tr>
<th>Feature</th>
<th>Linux</th>
<th>Windows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes (Color, Layer, and Publication)</td>
<td>Yes (Color, Layer, and Publication)</td>
</tr>
<tr>
<td></td>
<td>Yes (Color and Layer)</td>
<td></td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes (Windows)</td>
<td>Yes (Color and Layer)</td>
</tr>
<tr>
<td></td>
<td>No (Linux)</td>
<td></td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
<td>2D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes; Only surface bodies in the xy plane will be imported</td>
<td></td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes (Windows)</td>
<td>Yes (Windows)</td>
</tr>
<tr>
<td></td>
<td>No (Linux)</td>
<td></td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes (Windows)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>No (Linux)</td>
<td></td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes (Windows)</td>
<td></td>
</tr>
</tbody>
</table>

### Notations

**Selective Update (Windows)**  This interface fully supports the Selective Update feature.

**Selective Update (Linux)**  This interface does not support the Selective Update feature.

**Length Unit**  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Hidden parts**  Parts that are hidden or suppressed in CATIA V5 are skipped automatically by this interface.

**Import CAD Color as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Import CAD Layer as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3")
Import CAD Publication as an Attribute or Named Selection (Windows)

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Publication" or any number of prefixes with each prefix delimited by a semicolon (for example: "NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Publication" or any number of prefixes with each prefix delimited by a semicolon (for example: "NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded").

**Caveats and Known Issues (Windows)**

The CATIA V5 Reader has the following limitations:

**CATIA V5 R8 and earlier files are not supported**

CATPart files created in V5R8 or earlier that have been opened and re-saved in a later version of CATIA V5 are not supported.

**How to convert CATIA V5 R8 and earlier files to a newer supported version which will import with CATIA V5 Reader.**

1. open original CATPart and copy PartBody
2. open new Part then “Paste special” with “as result” option in part
3. close original CATPart
4. save new CATPart

**File Names.** The reader supports reading file names only within the ISO-646 subset of characters with the following limitations (file names with the following special characters are not supported):

- > (greater than)
- < (less than)
- * (asterisk)
- : (colon)
- ” (quotation mark)
- ? (question mark)
- \ (backslash)
- | (vertical bar)
- / (slash)

Additionally, all the *national accented characters* are also not supported.

- The Reader reads file names having their full path. The reader cannot read the file by file name only, or by using a relative path (for example, "..", ",", "\" or "\.").

**Reading Manufacturing Information.** The reader does not support reading:
Hole features from assembly files

User-defined patterns and its member hole features

Product Manufacturing Information without geometry ownership

**No Support for Transparency from an Assembly File.** The reader does not support reading transparency values in assembly (CATProduct) files.

**No Support for Captures from an Assembly File.** The reader does not support reading captures from assembly (CATProduct) files. Currently, support for captures is limited to part (CATPart) files only.

**No Support for CATPart Files Created in Small or Big Scale.** The CATIA V5 UI allows CATPart files to be created in Small or Big Scale. Also, the CATIA V5 UI allows the creation of CATProduct files referring to CATPart files from different Scales. The CATIA V5 Reader does not support reading of CATPart files created in Small or Big Scales. Similarly for the same reason, CATProduct files referring to such CATPart files might not be read partially or completely.

**Publication** Publication name defined with English characters is supported. Publication name defined with non-English characters is not supported.

**Small Scale** Small Scale models require the CATIA V5 Geometry Scale to be set to Small Scale. To change the scale setting to allow the import of Small Scale models:

1. Open a native CATIA V5 session
2. Select Tools: Options
3. Select General: Parameters and Measure
4. Select Scale tab
5. Change Geometry Scale from "Standard Scale" to "Small Scale"
6. Exit native CATIA V5 session
7. Set environment variable: `CATUserSettingPath=C:\Users\MyAccount\AppData\Roaming\DassaultSystemes\CATSettings`
8. Now start ANSYS Workbench and the CATIA V5 model will import correctly. Note: replace "C:\Users\MyAccount\AppData\Roaming" with your %appdata% value

**Caveats and Known Issues (Linux)**

The CATIA V5 Reader has the following limitations:

**Body Naming** Body hierarchy information is not available in all models. In some models, a generic label will appear in the tree.

**Troubleshooting**

See the CATIA Errors Related to CAD Integration (p. 121) section in CAD Integration Troubleshooting (p. 119) for detailed information.
CATIA V5 Associative Geometry Interface (*.CATPart, *.CATProduct)

The interface works in Pseudo-Reader (p. 123) mode.

The interface can be configured during ANSYS installation if the prerequisites are installed, or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

Windows: Configuring CAD Products> Using the CAD Configuration Manager

Prerequisites

The CATIA V5 associative geometry interface requires that the following software be installed and running:

- DSLS configured with a CATIA V5 (MD2, HD2, or ME2) license.
- CADNexus CAPRI CAE Gateway V3.22.0

Support

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Document import supported by interface: Part (*.CATPart) and Assembly (*.CATProduct)

Versions: V5R2 — V5–6R2016

Table 8: Import Preference Support for interface

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color, Layer, and Publication</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color, Layer, and Publication</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes- Only surface bodies in the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Notations

This is a Pseudo-Reader (p. 123) in ANSYS Workbench. There will be no ANSYS pull-down menu in the CATIA V5 program. It is not possible to update from the Active CAD file in CATIA V5.

Selective Update This interface fully supports the Selective Update feature.

Length Unit The application automatically locks the length unit in the model to millimeters. No adjustment of length unit is necessary or possible. You can change the unit system for display of the ANSYS Mechanical application data.

Hidden parts Parts that are hidden or suppressed in CATIA V5 are skipped automatically by this interface.

Import CAD Color as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

Import CAD Layer as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

Import CAD Publication as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Publication" or any number of prefixes with each prefix delimited by a semicolon (for example: "NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Publication" or any number of prefixes with each prefix delimited by a semicolon (for example: "NS_ForceFaces;NS_FixedSupports;NS_BoltLoaded").

Using Parameters with CATIA V5 (CADNexus CAPRI CAE Gateway)

- Parameter names contain the entire CATIA Assembly Name and Part Name.

- Parameters are shown at the assembly level, under the Details of Geometry branch in the ANSYS Mechanical application.
Embedded spaces should not be used in the Assembly Name or the Part Name to ensure compatibility with the DesignModeler Parameter Manager.

**Caveats and Known Issues**

The CATIA V5 associative geometry interface has the following limitations:

**Attach to Active CAD Geometry Option** The Attach to Active CAD Geometry is unavailable from CATIA.

**Material Properties** Must be assigned to the PartBody or GeometricSet to be imported. If you right mouse and move the Material Property under the PartBody or GeometricSet then they will be imported.

**WorkPoints** Only standard coordinate-defined points are supported (on Surface, on Line, etc. are not supported).

**Small Scale** Small Scale models require the CATIA V5 Geometry Scale to be set to Small Scale. To change the scale setting to allow the import of Small Scale models:

1. Open a native CATIA V5 session
2. Select Tools: Options
3. Select General: Parameters and Measure
4. Select Scale tab
5. Change Geometry Scale from "Standard Scale" to "Small Scale"
6. Exit native CATIA V5 session
7. Set environment variable: CATUserSettingPath=C:\Users\MyAccount\AppData\Roaming\DassaultSystemes\CATSettings
8. Now start ANSYS Workbench and the CATIA V5 model will import correctly. Note: replace "C:\Users\MyAccount\AppData\Roaming" with your %appdata% value

**Parameter Units.** Parameter Units (Millimeter, Inch...) are controlled by the CATIA V5 CATSettings.

How to change the CATIA V5 Parameter Units settings:

1. Open a native CATIA V5 session
2. Select Tools: Options
3. Select General: Parameters and Measure
4. Select Units tab
5. Select and change the Units for each of the parameters you want changed (example: Length)
6. Exit native CATIA V5 session
7. Now start ANSYS Workbench and the CATIA V5 model will import parameter values using the specified CATIA V5 Units.

**Note**

The CATIA V5 Units are saved in the CATSettings which are located at `CSIDL_APP-\DATA\DassaultSystemes\CATSettings` and referenced by CAPRI using the variable `CATUserSettingPath` which is setup in the CAPRI environment file (example: `CAPRI_CATIA_P3.V5R22.B22.txt`). To use a “non-default” CATSettings directory, change the `CATUserSettingPath` setting in the CAPRI environment file.

**Troubleshooting**

See the CATIA Errors Related to CAD Integration (p. 121) section in CAD Integration Troubleshooting (p. 119) for detailed information.

**CATIA V6 Reader (*.3dxml)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the CATIA V6 system be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

**Windows:** Configuring CAD Products > Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support > Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** Part (*.3dxml) and Assembly (*.3dxml)

**Versions:** R2010x — R2016x

**Table 9: Import Preference Support for Interface**

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Import Surface Bodies</th>
<th>Import Line Bodies</th>
<th>Parameter Processing and prefix/suffix key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**File Format Support**

Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
### Attribute Processing and prefix
- Yes - Color and Layer

### Named Selection Processing and prefix
- Yes - Color and Layer

### Material Processing
- No

### Analysis Type
- 3D - Yes
- 2D - Yes - Only surface bodies in the xy plane will be imported

### Notations

**Selective Update**  This interface does not support the Selective Update feature.

**Length Unit**  The application automatically locks the length unit in the model to millimeters. No adjustment of length unit is necessary or possible. You can change the unit system for display of the ANSYS Mechanical application data.

**Hidden parts**  Parts that are hidden or suppressed are skipped automatically by this interface.

### Import CAD Color as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

### Import CAD Layer as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

### Caveats and Known Issues

The CATIA V6 Reader has the following limitations:

**Only supports CATIA V6 - 3DXML with Authoring**  There are two types of 3DXML files which can be generated and exchanged. The "3DXML with authoring" (which include the export of geometry and meta-data) is supported by the CATIA V6 Reader. The "3DXML for review" is not supported by the CATIA V6 Reader.
**Body Naming**  Body hierarchy information is not available in all models. In some models, a generic label will appear in the tree.

**Troubleshooting**

See the CATIA Errors Related to CAD Integration (p. 121) section in CAD Integration Troubleshooting (p. 119) for detailed information.


The interface works in both a Plug-in (p. 123) and a Pseudo-Reader (p. 123) mode.

Updated CAD system on ANSYS Workbench compatibility information is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

**Windows:** Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** *.pkg, *.bdl, *.ses, *.sda, *.sdp, *.sdac, *.sdpc

**Table 10: Import Preference Support for Creo Elements/Direct Modeling geometry interface:**

<table>
<thead>
<tr>
<th>Import Solids</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>No</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes- Only surface bodies in the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
</tbody>
</table>
The Creo Elements/Direct geometry interface also supports the Selective Update feature.

Parts that are hidden or suppressed in Creo Elements/Direct Modeling are not skipped automatically, because of a limitation in the CAD's API.

Due to a limitation in the Creo Elements/Direct Modeling API, mixed import resolution will fail to correctly filter multi-body parts when one body type is owned by another body type.

SES files are not portable between different versions of Creo Elements/Direct Modeling. They should be limited to use on a single machine.

**Color Processing** Creo Elements/Direct Modeling does not expose body color directly, but the Plug-in (p. 123) can capture part color and automatically group each body into Named Selections which match their part color. This can be accomplished by adding the keyword "Color" to the Named Selection Key list. The resultant selection groups will be named with the form, Color:R.G.B. Here R, G and B are values ranging from 0 to 255, which represent the amount of color saturation of Red, Green and Blue color components. For example Color:0.0.0 is black, Color:255.255.255 is white, and Color:255.0.0 is red.

Within Mechanical body colors can be visually altered to match what is displayed in the Creo/Elements Direct session by executing the following steps:

1. Prior to attach/refresh, enable the Attributes preference.
2. Add the keyword "Color" to the Attributes Key list.
3. After attach/refresh is complete, within Mechanical perform Tools->Run Macro and designate this script to be run: `<install dir>`\v182 [version]\aisol\DesignSpace\DSPages\macros\BodyColorByCADColorAttribute.js

**Notations**

The Plug-in (p. 123) will import all parts in the model based on body type import filters. Active CAD session models imported from Creo Elements/Direct Modeling can only be updated from an active session unless the model is re-linked to a specified file. A model imported based on its file can only be updated from the file unless re-linked to an active session. Attempting to import a Creo Elements/Direct Modeling file from disk when a session of the CAD is opened will fail so as to not corrupt the active model.

The absence of an ANSYS section in the Add-In Modules fly-out menu indicates that the Creo Elements/Direct Modeling Plug-in (p. 123) is not loaded. To load the Plug-in (p. 123) into Creo Elements/Direct, you must first open Creo Elements/Direct Modeling and select Modules under the File Ribbon Tab. Select the Add-Ins item and check the box for ANSYS; this will load the plug-in for the current session. To have the plug-in loaded on start-up of subsequent sessions select the Startup button, highlight ANSYS and
select Add. The Add-In manager will then list ANSYS 18.0 in the Startup Sequence. Note that because
the ANSYS menu does not appear after installing the plug-in, you must use the preceding steps for
loading on start-up. If the plug-in is not available in the Creo Add-In manager you will need to run the
CAD Configuration Manager (p. 22).

If a "NET initialization failed" error message is seen while activating the ANSYS 18.2 module, follow the
steps below to fix it:

1. From a command prompt navigate to the Creo Elements/Direct installation directory. There will be a
   bin <platform> underneath that, cd into it. Then type the following command: SolidDesigner.exe
   -register
2. Rerun CAD Configuration Manager (p. 22) for CED.

**Configuration Considerations**

Due system registry restrictions with Creo Elements/Direct Modeling, the CAD Configuration Man-
ger (p. 22)'s option to configure for "current user" will impact the Geometry Interface's availability for
all other users if the current user is the admin.

**Creo Parametric (*.prt, *.asm)**

For more information, see:

- Creo Parametric Reader (*.prt, *.prt.*, *.asm, *.asm.*)
- Creo Parametric Associative Geometry Interface (*.prt, *.asm)

**Creo Parametric Reader (*.prt, *.prt.*, *.asm, *.asm.*)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the Creo Parametric (formerly Pro/ENGINEER) system
  be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

  **Windows**: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the and Windows (p. 7) platform is
accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the
Document import supported by interface: Part (*.prt, *.prt.*) and Assembly (*.asm, *.asm.*).

Versions: 16 — Creo 4.0

Table 11: Import Preference Support for interface

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td>2D - Yes: Only surface bodies in the xy plane will be imported</td>
<td></td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes</td>
</tr>
</tbody>
</table>

Notations

Selective Update  This interface fully supports the Selective Update feature.

Length Unit  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

Hidden Parts  Parts that are hidden or suppressed in Creo Parametric are skipped automatically by this interface.

Import CAD Color as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

Import CAD Layer as an Attribute or Named Selection
- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3")

### Caveats and Known Issues

The Creo Parametric Reader has the following limitations:

**Limited Support for Layer Information**  
Only layers in Creo Parametric faces are read; Creo Parametric bodies and edges do not have layer information. Layer information is not supported for Pro/E Wildfire 4.

**Limited Support for 2D Sketch, Cosmetic Groove and Curve Features**  
The Creo Parametric features 2D sketch, cosmetic groove and curve using equation and local push are not supported.

**Limited Support for Suppressed Entities**  
Suppressed entities are not supported at Part level.

**LCS from Only “Part” Files are Translated**  
LCS from only “Part” files (.prt files) is translated and written to corresponding .sat files while reading assembly files by XML route. However, LCS of “Part” files is not translated while reading assembly files by flatten route.

**User Defined Attributes**  
The Reader will not support user-defined attributes created under Feature, Inherited, Annotation element, Quilt, Surface, Edge, Curve, Composite curve, and Material level.

**Limited Support for Material Properties**  
The custom system of Unit is not supported. The local modification (independent of file level) in a unit of material property is not supported.

**Reading Manufacturing Information from Assembly Files**  
The Reader does not support reading PMI data and Hole feature from assembly files.

**Limited Support for Assembly Cut Feature**  
The Reader supports the assembly cut feature for subtraction operations only.

**Limited Support for Simplified Representation**  
The Creo Parametric Reader does not support part level Simplified Representation. The default SimpRep cannot be used when Derived Exclude rep is used at the part level in a user-defined rep at the sub-assembly level.

**Limited Support for Assembly Color and Transparency Property**  
The Creo Parametric Reader does not support root assembly level Color and Transparency property.

**Limited Support for Hidden Entity**  
The Creo Parametric modeler allows for hiding merge features, but the Creo Parametric viewer does not update that information. Hence, the reader does not guarantee correct translation for this hidden feature. The reader will not support user-defined attributes with Unicode characters.

**Limited Support for Working Coordinate Systems**  
Assembly level working coordinate systems are not supported, only Part level working coordinate systems are supported.

**No Support for flexible assemblies**  
It will not read instance specific transformation or other information from flexible components. Thus, positioning and/or sizing of components might be incorrect in case of flexible assemblies.
Troubleshooting

See the Creo Parametric Errors Related to CAD Integration (p. 121) section in CAD Integration Troubleshooting (p. 119) for detailed information.

Creo Parametric Associative Geometry Interface (*.prt, *.asm)

Before installing the ANSYS application, make sure you have installed Creo Parametric and have run the program at least once under the user login that you will use to install the ANSYS Workbench.

The interface works in both a Plug-in (p. 123) and a Pseudo-Reader (p. 123) on Windows.

The existence of the Plug-in (p. 123) is recognized by Creo Parametric based upon an entry in the configuration file (config.pro) referencing a Pro/Toolkit registry file located in the ANSYS Workbench installation (WBPlugInPE.dat). This is configured during the installation process whenever you select Creo Parametric as a geometry source, but can be modified to enable/disable the Plug-in (p. 123) by using the CAD Configuration Manager. The CAD Configuration Manager can also be used to change the Creo Parametric installation utilized by the Plug-In. If Creo Parametric was not selected in the original installation then the Associative Plug-In will not be available for configuration. In this case you can run the installer and select Creo Parametric under ANSYS Geometry Interfaces to make the Associative Plug-In available.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

Windows: Configuring CAD Products> Using the CAD Configuration Manager

Support

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support> ANSYS 18.0 - CAD Support). See ANSYS Platform Support.

Document import supported by interface: Part (*.prt) and Assembly (*.asm)

Table 12: Import Preference Support for Creo Parametric geometry interface

<table>
<thead>
<tr>
<th>Import Solids</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes - Datum Curves</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - from ANSYS Named Selection Manager (p. 22) and programmatically created attributes</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td>Feature</td>
<td>Value</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>-------</td>
</tr>
<tr>
<td>2D - Yes- Only surface bodies in the xy plane will be imported</td>
<td></td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes</td>
</tr>
<tr>
<td>Smart Update</td>
<td>Yes</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed import Resolution</td>
<td>Yes - for parts that include both Solid and surface bodies AND the Import Solid and Import Surface preferences are set to Yes</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes (for use with faces only)</td>
</tr>
</tbody>
</table>

**Notations**

The Creo Parametric geometry interface also supports the Selective Update feature.

Assembly parts and sub-assemblies that are hidden or suppressed in Creo Parametric are automatically excluded from import into ANSYS Mechanical and DesignModeler.

If you switch between the Master and simplified representations of your geometry in Creo Parametric, you must use the Erase Not Displayed option in Creo Parametric to remove the geometry not shown in Creo Parametric window (but resident in memory) before attaching or refreshing in the ANSYS Mechanical or DesignModeler application.

**Importing Feature Types as Line Bodies**  The Datum Curve feature types can be imported from Creo Parametric into ANSYS Workbench’s Mechanical or DesignModeler application as line bodies.

**Length Unit**  The length unit specified in the Creo Parametric part or assembly is transferred into ANSYS Workbench. Assemblies and their component parts should all be constructed using the same length unit. Models with mixed units will trigger a warning indicating the model error. Models with mixed units may not display, mesh, or export to other formats (including SpaceClaim or DesignModeler) as desired.

Parts in a unit system other than the assembly’s unit system may have incorrect properties and data. These parts should be modified at their source and the imported models updated in ANSYS Workbench.

PTC provided a workaround for Creo Parametric. This enhancement allows a user to make all parts and sub-assembly components have the same units as the root assembly. To achieve consistent units, perform the following steps:

1. Add a line to your `config.pro` stating: `allow_multiple_units_conversion yes` (This is not required for Creo Parametric 2.0 M070 and later)

2. Open the assembly within Creo Parametric

3. Open the Model Properties Utility (File> Prepare> Model Properties)

4. Specify the desired units by choosing Change Units, then select the desired unit type and check “Include Submodels”
5. Upon finalizing unit choice via the “Set” button, accept the required field informing you that the “Convert Dimensions” option is being used.

When using an assembly's offset as a parameter, a negative value will cause the direction of the offset to flip and the value will be returned with a positive sign.

Caveats and Known Issues

In no particular order, the caveats and known issues are:

- Coordinate System Naming (p. 61)
- Capturing a Body in a Named Selection (p. 61)
- Surface Body Naming Convention (p. 61)
- Layer Considerations (p. 61)
- Updating Instances (p. 62)
- Material Data (p. 62)
- File Versions (p. 62)
- Configuration Considerations (p. 63)
- Decompose Disjoint Geometry (p. 63)
- DesignModeler Considerations (p. 64)
- Parametric Updates (p. 64)
- Smart Update (p. 65)
- Using Seed and Boundary with Named Selections (p. 65)
- Limitations (p. 66)

Coordinate System Naming

When importing a Creo Parametric assembly with a coordinate system, default names starting with numbers are replaced with new names. During the import, typically a warning message is displayed that reads, "feature name not valid due to invalid characters."

In addition, the list of coordinate systems is not updated after refreshing the import operation.

Capturing a Body in a Named Selection

The Named Selection Manager (p. 22) does not directly offer a mechanism for adding solid bodies to a Named Selection Group; however, any solid bodies, features or quilts contained within a Creo Parametric layer matching the named selection key will have their faces and edges included in a group with the same name as the layer. When importing to Mechanical, each Named Selection containing bodies will be divided into two separate Named Selections; one containing each body’s faces, the other containing edges. When the Named Selection Key is left blank, layers will not be processed for named selection. The method of defining named selections requires explicitly matching the prefix of the layer name. If you wish to capture all Creo layers as named selections use the Named Selection Key "Layer".

Surface Body Naming Convention

Surface bodies imported into the ANSYS DesignModeler, ANSYS SpaceClaim Direct Modeler, and the ANSYS Mechanical application include numerical references to the parent part or assembly and Creo Parametric quilt ID. For example, a part named H103 with three Creo Parametric quilts 1, 2, and 3 will be identified as H103[1], H103[2] and H103[3].

Layer Considerations

Solid or Quilt bodies belonging to a hidden Creo layer will be not be imported when the layer is hidden.
Note that changing layer visibility in Creo Parametric does not mark a part/assembly as modified. To pick up such a change in state when importing to Mechanical, SpaceClaim or DesignModeler the Geometry cell’s Smart Update preference must be disabled.

**Updating Instances**

**Model Instances** If you wish to update a particular instance of a model, it is necessary that the active model in Creo Parametric be the desired instance, otherwise a generic version of the instance will be used for the update.

**Part Instances** Within the Creo Parametric assembly, any component impacted by any assembly level feature will not be processed as an instance (p. 123), but the full geometry will be imported. Note that for models where an assembly feature was modified so that component(s) are no longer impacted, you may still be required to update the intersection information manually otherwise the Plug-in (p. 123) will not be able to process them as instances. The following procedure describes the process of manual update of intersection data for Creo 3.0:

1. Enable feature visibility (Model Tree > Settings > Tree Filters > Display Features)
2. Select Assembly Feature for Edit
3. Navigate to the feature’s Intersection tab
4. Disable Automatic Update
5. Remove all components in the list
6. Check Automatic Updates
7. Accept the feature changes

**Material Data**

Material data can be transferred into ANSYS Workbench provided one or more of the material properties are defined for the Creo Parametric material. The properties for a Material are Density, Poisson’s Ratio, Young’s Modulus, Coefficient of Thermal Expansion, Specific Heat Capacity and Thermal Conductivity.

**File Versions**

Multiple versions of Creo Parametric files are designated with a .# extension that is appended to the .prt or .asm extension (for example, wrench.prt.1, wrench.prt.2 are names of two Creo Parametric file versions). You can access a specific version of a Creo Parametric file through the ANSYS Workbench Project Schematic.

You are strongly advised to avoid stripping the version numbers from Creo Parametric files for the following reasons:

- If you open a stripped version of the file in Creo Parametric and import the file via the Plug-in (p. 123), it will indicate the wrong version if there is any other version of that part file in the same directory.
- If you attempt to load a stripped version of the file by using the Pseudo-Reader (p. 123), the highest file version of that model will be loaded.

Regarding the updating of Creo Parametric file versions, updating will be version specific if you use the reader or if you do not open a copy of that model with the same name in a Creo Parametric interactive
However, if you open one version of a model in Creo Parametric and you request the same model, but a different version for attach or update, the currently active version will be assumed to be the one that you want. This assumption is necessary for the following reasons:

- Creo Parametric does not allow two different versions of the same part to be active at one time, using the same name.

- If you save a model in a Creo Parametric session, its version is incremented (for example, if you attach via the Plug-in (p. 123) with version 3, then save the model in Creo Parametric, the version of the active model would be version 4).

**Configuration Considerations**

If an active Creo Parametric file does not appear under Active CAD Files, either Creo Parametric is not running or the ANSYS Workbench Plug-in (p. 123) for Creo Parametric is not loaded. For this last condition, run the CAD Configuration Manager. See Using the CAD Configuration Manager in the ANSYS, Inc. Windows Installation Guide for detailed information.

On some Windows systems, where the Plug-in (p. 123) was configured for only the current Administrator, the ANSYS Geometry Interfaces to Creo Parametric are not loaded as expected after being selected for install. This is because Creo Parametric is not detecting the required configuration file in the user’s login folder (either %HOME% or %HOMEDRIVE%\%HOMEPATH%). **Work-around:** Copy the file named config.pro from your login directory to Creo Parametric start-up directory which can be determined by either examining the properties for the shortcut used to launch Creo or by running `<path to Creo Parametric install>\bin\ptcsetup.bat`.

On the Windows platform, users without write access to their ANSYS Workbench installation may encounter the following error when attempting to import Creo Parametric models without an active CAD session: "No write access, please choose another start-up directory for trail file creation". This issue can be addressed by specifying an alternate location for Creo Parametric to create trail files. The `trail_dir` directive for the config.pro file is the mechanism offered by PTC. For example, adding the line `trail_dir $TEMP` to the config.pro file will force Creo Parametric to create trail files in the location referenced by the TEMP environment variable.

Administrative users should avoid configuring the Creo Parametric Associative Geometry interface both for "All Users" and "Current User". Non-Administrative users should avoid configuring the interface for the same Creo installation that an Administrator has already setup for "All Users". When a non-Administrative user configures for a Creo version different than that already configured for all users, that user's import will work normally for only the CAD version specified by the non-admin user.

Creo Parametric can potentially leave behind the ANSYS ribbon tab after unconfiguring the Plug-In. In this case, the ribbon tab can be manually removed by deleting `%APPDATA%\PTC\ProENGINEER\Wildfire\wf.\Settings\creo_parametric_customization.ui`. In cases where the config.pro directive "load_ui_customization_run_dir" is set to yes this file will instead be located in the Creo start in directory.

**Decompose Disjoint Geometry**

Creo Parametric supports surfaces with multiple external contours; prior to Workbench 14.0 these were represented as a single, disjoint face when transferred to the ANSYS Mechanical application. To add greater flexibility in the ANSYS Mechanical, DesignModeler, or SpaceClaim Direct Modeler application and preserve unique IDs, a preference has been added to break apart the Creo Parametric surfaces into a single face for each external contour during import. In DesignModeler and SCDM, decomposition will
always be attempted. In Mechanical, decomposition is the default pre-selected behavior, but can be disabled when desired.

Associativity will be maintained for sub-faces as long as the edges composing the external contour are static. Adjusting the sketch elements from which the external contour is defined, such that their internal identifiers change, will likely result in lost associativity.

**DesignModeler Considerations**

When a Creo Parametric model does not attach in the DesignModeler application but does attach in the ANSYS Mechanical application,

1. A possible cause is a Round or Fillet radius in Creo Parametric that is failing to translate. You may find the cause by suppressing some or all of the Rounds or Fillets in the Creo Parametric model and then try to attach in the DesignModeler application.

2. Creo Parametric Model tolerance (Accuracy) is too loose. You may be able attach the model successfully by setting Creo Parametric to use Absolute Accuracy along with a tighter tolerance.

To do so, edit the file named “config.pro” in the Creo Parametric.

1. In Config.pro, add:
   
   ```
   enable_absolute_accuracy yes
   accuracy_lower_bound 1.0e-7
   ```

2. Open the model in Creo Parametric

3. Accuracy>Absolute>[Enter new value]-->-->Regen>Yes

   For example, if the Absolute Accuracy Value is [1.2000e-03 mm], then try entering a new value that is 0.5 times that [0.6000e-04 mm]

Future Creo Parametric models can be created with tighter tolerance from the start (two orders of magnitude tighter than default) although may result in increased memory use and diminished performance. Note that after tightening a model’s tolerance it can fail to regenerate. If so, you can attempt less restrictive values until you find the one that will regenerate and translate into the DesignModeler application. However, not every model can regenerate at a tight enough tolerance to successfully translate.

In cases where adjusting the absolute tolerance does not work, you may need to defeature parts of the model until it imports successfully.

**Parametric Updates**

There is a known problem performing parametric updates of Creo Parametric models which contain parameters with "locked" access. The Creo Parametric API does not provide information regarding the access state of parameters and the Creo/Toolkit does not detect assembly parameter relationships driven by dimensions. This can result in refresh failure. **Work-around:** Ensure that locked parameters do not have a prefix/suffix corresponding to the existing parameter filter to prevent their import.

Model regenerations will fail when you have the configuration setting regen_failure_handling set to resolve_mode. This setting must either be left undefined or given the value no_resolve_mode for successful parametric updates.
When working in Creo Parametric's Simulation environment (Applications->Simulate) specifying an out of range parameter value can leave the CAD model in an undesirable state following update.

**Smart Update**

In order for the Geometry Interface to effectively identify and skip retrieval of unchanged assembly components the following requirements must be met:

1. Mass Density must be defined for all assembly components.
2. Model must be fully regenerated.
3. Model must be saved before being retrieved using Reader mode (Creo Parameteric session is not active at time attach/refresh is initiated).

---

**Note**

Mass density can be applied to assembly components without a preexisting setting by either of the following methods:

- **Either:** File> Prepare> Model Properties> Mass Properties> Change > Specify Density Value -> Generate Report. Then accept the prompts for each component to which the value is to be applied.

- **Or:** Defining a model parameter MP_DENSITY and specifying the value in the column next to each component. The model parameter can be created from Setting Menu> Tree Columns> Type: Model Params> Name: MP_DENSITY> Click right arrow to move into Displayed Column.

---

**2D Analysis Considerations.** Some surfaces which appear eligible for 2D analysis in Creo Parametric may be filtered during import, because their Z extent is beyond tolerance from the XY plane. Tolerance is considered to be 10e-5 multiplied by the surfaces diagonal length.

**Using Seed and Boundary with Named Selections**

The Associative Geometry Interface supports the Creo’s Seed and Boundary selection technique as a means of adding groups of surfaces to a Named Selection. Seed and Boundary selection can be performed as follows:

1. Choose "Geometry" as the Creo selection filter.
2. Select a surface as **Seed**
3. Press **SHIFT**-Key (keep pressed)
4. Select another surface, or set of surfaces, as **Boundary**
5. Release the **SHIFT**-Key

The result is that all surfaces from **Seed** to the **Boundary** are selected excluding the Boundary surface. These can then be added to a Named Selection via the Create and replace options in the Named Selection Manager.
Limitations

**Creo Platform Agent Corrupt**  When the installation of this PTC utility is broken it will block the startup of the ANSYS Creo plug-in. To work around this problem you can either (a) set the environment variable PROTK_DELAYINIT_NO_DELAY=TRUE, or (b) reinstall Creo to correct the problem with Creo Agent.

**Interface load failure**  A regression was introduced to Creo Parametric 2.0 M150 and Creo Parametric 3.0 M040 which prevents the ANSYS plug-in from automatically loading into the CAD. PTC has resolved this problem in Creo Parametric 2.0 M170 and Creo Parametric M050. If you are running one of the effected versions it is recommended that you upgrade to the newer maintenance release. If you are unable to move from the effected versions, an alternate work-around is to copy %AWP_ROOT170%\CADIntegration\ProE\ProEPages\config\WBPlugInPE.dat to your Creo Parametric start-in folder.

**Mixed Unit Support**  All parts and sub-assemblies should be in the same unit. Models with mixed units imported into the ANSYS Mechanical application will trigger a warning indicating the mixed unit. Note that Siemens NX and PTC Creo are the only CAD systems that can provide mixed unit assembly data correctly to ANSYS Workbench.

**Missing faces in Named Selections from Layers**  There is a known problem where some disjoint faces belonging to Creo Parametric Layers are incorrectly left out of a Workbench Named Selection or AIM Selection Set. The work-around to this problem is to import with the Decompose Disjoint Geometry preference disabled.

**Parameter Value Out of Allowable Range**  There is a known problem performing model update when one or more parametric values are outside the CAD's allowable range for a given dimension or parameter. In such cases the geometry interface will retrieve the model with parameter value matching the last successful regeneration in Creo, but the Workbench Project page will indicate the parameter's value to be the last requested value (out of range). This behavior is only observed with Creo Parametric 3.0. Updates performed with Creo Parametric 2.0 and Wildfire 5 will clearly indicate "Regeneration Failure" when supplied with a parameter which is out of range.

**Relationship Driven Sketch Parameters**  Feature parameters linked to relation defined sketch or section dimensions will import to Workbench as Independent parameters due to a known problem in Creo. Any attempts to refresh/update the model with a changed value for such parameters will result in either an unexpected parameter value or aborted update due to a Creo regeneration failure.

**Web Homepage**  It has been occasionally observed that setting Creo Parametric 2.0 to load certain webpages at startup, via the config.pro directive web_browser_homepage, can invalidate import of arc type edges. This issue can result in mesh failures within Mechanical and non manifold geometry in DesignModeler. To resolve this issue you can either update to the latest datecode of Creo Parametric 2.0 or remove the web_browser_homepage from your config.pro file.

**Windchill Conflicts**  The environment variable PTC_WF_ROOT, used to define the default workspace cache location, can break import models not residing in the Creo start-in folder. The workaround is to use PTC_WLD_ROOT instead of PTC_WF_ROOT.

**ANSYS DesignModeler (.agdb)**

**ANSYS DesignModeler** topics:

- Face Geometry Transfer (p. 67)
Face Geometry Transfer

Faces without associated geometry may be generated when attaching to a CAD system or when importing from a file. This may occur for all CAD systems or file formats with the exception of Parasolid (*.x_t, *.xmt_txt, *.x_b, *.xmt_bin) (p. 83), IGES (*.igs, *.iges) (p. 72), STEP (*.stp, *.step) (p. 100), Monte Carlo N-Particle (*.mcnp) (p. 76), ANSYS BladeGen (.bgd) and ANSYS DesignModeler (.agdb). Loading geometry into the ANSYS DesignModeler application may result in a greater frequency of occurrence of such faces than when loading geometry into the ANSYS Mechanical application. In addition, such faces may be more often observed with the GAMBIT (*.dbs) (p. 70) Reader's processing of non-real geometry than for other CAD systems or file formats.

The ANSYS Mechanical application will fail to construct a part when an associated face without geometry is found and will report an error.

The ANSYS DesignModeler application will construct parts excluding faces without geometry. A solid or surface body in the CAD system or file with such faces detected will result in surface bodies being constructed. The constructed surface bodies are generated from the faces with geometry and will consist of the faces that are connected by shared edges. If the Line Bodies property is set to "Yes" (enabling import of line bodies), then line bodies will be constructed from edges only belonging to faces without geometry that have been removed. A warning message indicating a partial import will be generated for all parts that have been imported in ANSYS DesignModeler with faces without geometry having been removed.

Example 1: Face Geometry Transfer Scenarios

Shown above is a body with two faces highlighted for which geometry is not constructed during transfer.
Shown above is a body in the ANSYS DesignModeler DesignModeler application where two faces are not being transferred.

Shown above is a body in the ANSYS DesignModeler application where two faces are not being transferred and the Line Bodies property is set to yes.

**Specific to ANSYS Mechanical**

The ANSYS Mechanical application supports the DesignModeler application as both a pseudo-reader and a plug-in.

**Attaching Geometry**

Unlike other CAD systems, filtering of bodies during import from DesignModeler to the ANSYS Mechanical application is not done through import options. All unsuppressed bodies in ANSYS DesignModeler will be transferred to the ANSYS Mechanical application.

Any planes in the ANSYS DesignModeler application that are flagged to be exported will appear in the ANSYS Mechanical application as a local Cartesian coordinate system upon attachment and will be in-
serted into the ANSYS Mechanical application tree. The automatic creation of the coordinate system occurs during attachment and is updated during a refresh.

Any enclosures defined with a model in the ANSYS DesignModeler application will be retained upon attaching. Once in the ANSYS Mechanical application, the enclosure has the following characteristics:

- A transparency value of 0.1 (subdued) is assigned to the enclosure to assist in the visualization of the model items inside the enclosure.

- A default field material of Air is automatically assigned to the enclosure. You can change the default field material in Engineering Data. A field material is used in any open domain simulation where an artificial boundary such as an enclosure is used to surround the model. Any fields extending from the model to the edges of the enclosure experience the field material.

You can control whether Coordinate Systems and Enclosures that are created in the DesignModeler application files are imported in the ANSYS Mechanical application by checking the Advanced Geometry Options (p. 13), specifically:

- Import Coordinate Systems
- Enclosure and Symmetry Processing

**Parts and Assemblies**

The ANSYS DesignModeler application does not support assemblies, but does allow you to create and import multiple bodies. If you import a model made up of independent multiple bodies, they will be imported into the ANSYS Mechanical application as individual bodies using contact elements.

If you import a model that has multibody parts (that is, parts that include multiple bodies within them as a group), then the model will be imported using shared topology so that no contact is required and meshes on the volume interfaces will match.

The ANSYS DesignModeler application parameters are all set at the model level. Since ANSYS DesignModeler publishes its own parameters to the project schematic, its parameters are not displayed in the ANSYS Mechanical application under the Geometry branch.

For line body properties that appear in the ANSYS Mechanical application, the values shown are for the raw cross section, that is, the offset type and/or user defined offset from the ANSYS DesignModeler application's body properties have no bearing on the calculations shown in the ANSYS Mechanical application. They are taken directly from the cross section without applying any offset.

Surface body thicknesses and material properties are transferred from the ANSYS DesignModeler application to the ANSYS Mechanical application.

**Notations**

If you are using the ANSYS DesignModeler application as a pseudo-reader, the ANSYS Mechanical application will maintain associativity with the ANSYS DesignModeler application model. If you modify parameters in the ANSYS Mechanical application, the ANSYS DesignModeler application model will change upon update.

Models that have fatal errors when regenerating in the ANSYS DesignModeler application will not be able to be imported via the reader mode into the ANSYS Mechanical application. Before importing, first open the model in the ANSYS DesignModeler application to resolve the regeneration failures.
When the ANSYS Mechanical application is first attached to an ANSYS DesignModeler application, the Fluid/Solid property associated with all DesignModeler solid bodies will be transferred to a Material Assignment property for all associated solid bodies in the Mechanical application. However, when refreshing all data in the Mechanical application, following an initial attach to DesignModeler, the Mechanical application Material Assignment property for solid bodies will not be updated further.

**Length Unit**

The ANSYS Mechanical application automatically sets the length unit to match the units used in the ANSYS Workbench project itself, not the length unit of the model in the ANSYS DesignModeler.

**Specific to SpaceClaim**

SpaceClaim does not support the import of non-manifold geometry. If the DesignModeler geometry contains shared topology, it will be rolled back to the state just before the shared topology was created before transferring it to SpaceClaim.

**GAMBIT (*.dbs)**

GAMBIT Reader (*.dbs)

The interface works in a Reader mode.

- This is a stand-alone reader which does not require that the GAMBIT system be installed.
- No CAD associativity support.
- No CAD Parameter support.
- Supports GAMBIT volumes, faces, edges, and vertices (excluding stand-alone vertices).

This interface is configured during ANSYS installation by default.

The GAMBIT Reader in ANSYS Workbench processes GAMBIT volumes along with stand-alone (no upper topology) faces and edges. Stand-alone vertices are not processed. GAMBIT non-manifold topology is supported. Multiple volumes sharing common faces will form a single part. When the GAMBIT database is imported into the ANSYS Mechanical application, shared faces will not be duplicated. When importing into the ANSYS DesignModeler application, solid bodies in a multi-body part will be separate forming a manifold model (shared GAMBIT faces will be duplicated for each body). Stand-alone faces sharing common edges will form surface bodies and stand-alone edges sharing common vertices will form line bodies.

Beginning with release 14 of ANSYS Workbench, GAMBIT real and non-real (virtual, faceted, CAD) geometry may be processed. Prior to release 14 of ANSYS Workbench, only GAMBIT real geometry (including hidden real geometry) would be processed. By processing real and non-real geometry, the GAMBIT geometry can be more accurately represented in ANSYS Workbench. However, processing of non-real geometry may be problematic, especially for complex surfaces (for example, as may occur in biomedical models). See Face Geometry Transfer (p. 67) for further details.

When importing a GAMBIT database into the ANSYS Mechanical application, real and non-real geometry will be processed. Note that an ANSYS Workbench project created prior to release 14—involving the
import of a GAMBIT database into the ANSYS Mechanical application—may result in a different geometric model in release 14 of ANSYS Workbench or later.

When importing a GAMBIT database into the ANSYS DesignModeler application, you will be able to specify either “Real and Non-real” or “Real Only” geometric processing, using a “GAMBIT Geometry” property. You may find that a more optimal import may result by selecting a specific geometric processing option.

The option is located in the DesignModeler Geometry Options section of the Details View.

Support

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Document import supported by interface: *.dbs

Versions: up to 2.4.6

Table 13: Import Preference Support for GAMBIT geometry interface

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
</tbody>
</table>
### Notations

**ANSYS DesignModeler Compatibility**  The ANSYS DesignModeler application allows you to import legacy GAMBIT databases into ANSYS Workbench for editing. Real and non-real (virtual, faceted, CAD) geometry may be read from the database. GAMBIT mesh data, boundary or continuum zones, coordinate systems and other objects are not read. If no editing is needed, the model may be directly imported into the ANSYS Mechanical application.

**Assembly**  Although the GAMBIT geometry format does not have an assembly entity, the application supports GAMBIT files containing one or multiple bodies.

**Hidden Parts**  Parts that are hidden or suppressed in GAMBIT are skipped automatically by this interface.

**Length Unit**  The application automatically locks the length unit in the model to millimeters. No adjustment of length unit is necessary or possible. You can change the unit system for display of the ANSYS Mechanical application data.

**Non-manifold Topology**  The GAMBIT Reader in Workbench processes GAMBIT volumes along with stand-alone faces and edges. Non-manifold topology is supported (for example, two blocks sharing a common face and lower topology vertices and edges).

**Real and Non-Real Geometry**  The GAMBIT Reader supports real (ACIS) geometry and non-real (Virtual, Faceted and CAD) GAMBIT geometry.

**Selective Update**  This interface does not support the Selective Update feature.

### Caveats and Known Issues

See processing real and non-real geometry (p. 70) information.

### IGES (*.igs, *.iges)

The application supports IGES files as a Reader (p. 123).
The existence of the Plug-in (p. 123) is recognized by IGES on registry entries. If the plug-in is not available in the add-in manager in Autodesk Inventor (*.ipt, *.iam) (p. 38) you will need to run the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Linux**: Configuring CAD Products> Using the CAD Configuration Manager
- **Windows**: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface**: *.igs, *.iges

**Table 14: Import Preference Support for IGES geometry interface**

<table>
<thead>
<tr>
<th>Import Solids</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>Yes</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>1. Only supported for ANSYS Mechanical; not supported in DesignModeler</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

**Notations**

IGES imports sets of surfaces that enclose a region to create a solid body.
IGES models cannot be imported if they contain bodies that extend beyond 500 meters in any direction from the world origin, even when the Large Model Support option is enabled. For IGES imports to be successful, the model must fit inside the base 1 km^3 size box.

Similar in behavior to IGES files exported from ANSYS Mechanical APDL, IGES models that do not have a defined unit system in the file will be interpreted as inch units upon import into ANSYS DesignModeler and/or ANSYS Workbench; i.e. 1.0 = 1 inch.

**Specific to ANSYS Mechanical**

The IGES reader converts IGES information written in 5.3 format and before into Parasolid (*.x_t, *.xmt_txt, *.x_b, *.xmt_bin) (p. 83) data.

**Part and Assemblies Files**  IGES files containing parts or assemblies are supported by the ANSYS Mechanical application. IGES files can use the extensions .igs or .iges.

**Length Unit**  The ANSYS Mechanical application automatically sets the length unit in the part or assembly to meters. No adjustment of length unit is necessary or possible.

**Body Instancing**  If the Import Using Instances property is enabled, then body instances will be generated in Mechanical/Meshing for any IGES file with body instances.

**Caveats and Known Issues**

No caveats or known issues.

**JT Reader (*.jt)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the JT system be installed.
- No CAD associativity support.
- No CAD Parameters support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Windows**: Configuring CAD Products > Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support > Platform Support). See ANSYS Platform Support.
Document import supported by interface: Part (*.jt)

Versions: 6.4 — 10.0

Table 15: Import Preference Support for Interface

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes — Color</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes — Color</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
</tbody>
</table>
| Analysis Type                                | 3D - Yes  
|                                              | 2D - Yes: Only surface bodies in the xy plane will be imported |
| Associativity                                | No      |
| Coordinate Systems                           | No      |
| Work Points                                  | No      |
| Reader Save File                             | No      |
| Instancing                                   | No      |
| Smart Update                                 | No      |
| Enclosure and Symmetry Processing            | No      |
| Mixed Import Resolution                      | No      |
| Decompose Disjoint Geometry                  | No      |

Notations

Selective Update  This interface does not support the Selective Update feature.

Length Unit  The application automatically locks the length unit in the model to millimeters. No adjustment of length unit is necessary or possible. You can change the unit system for display of the ANSYS Mechanical application data.

Hidden Parts  Parts that are hidden or suppressed are skipped automatically by this interface.

Import CAD Color as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

Caveats and Known Issues

The JT Reader has the following limitations:
**File Format Support**

**JT B-REP representation support.** NURBS Surfaces, trimmed by NURBS curves.

**JT Tessellation-only data files are not supported.** JT Reader requires that the JT file contains Boundary Representation (B-rep) data.

**Body Naming.** Body hierarchy information is not available in all models. In some models, a generic label will appear in the tree.

**Troubleshooting**

See the JT Errors Related to CAD Integration in the [CAD Integration Troubleshooting](#) (p. 119) section for detailed information.

**Monte Carlo N-Particle (*.mcnp)**

The application supports Monte Carlo N-Particle files as [Reader](#) (p. 123).

- This is a stand-alone reader that does not require an installation of the Monte Carlo N-Particle CAD program.
- No CAD associativity.
- No CAD Parameters.
- The MCNP format contains solid bodies only. Surfaces and lines will be ignored.

**Support**

At the time of release, detailed version support information for the [Linux](#) (p. 5) and [Windows](#) (p. 7) platforms is accessible via [Geometry Interface Support](#) (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See [ANSYS Platform Support](#).

This is a stand-alone reader, which does not require an installation of the Monte Carlo N-Particle software or a Monte Carlo N-Particle license.

**Document import supported by interface:** *.mcnp*

**Notations**

Monte Carlo N-Particle database files can only be read into ANSYS DesignModeler (p. 66). They cannot be imported directly into the ANSYS Mechanical application.

Monte Carlo N-Particle database files must be updated with the Generate option prior to proceeding with an analysis.

When importing an MCNP file, the solid body representing the outside world body is automatically hidden.

**Caveats and Known Issues**

No caveats or known issues.
NX (*.prt)

For more information, see:
- NX Reader (*.prt)
- NX Associative Geometry Interface (*.prt)

**NX Reader (*.prt)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader that does not require the NX system be installed.
- No CAD associativity support.
- No CAD Parameter support.

This interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

**Windows**: Configuring CAD Products > Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support > Platform Support). See ANSYS Platform Support.

**Document import supported by interface**: Part (*.prt) and Assembly (*.prt)

**Versions**: 11–NX 11

**Table 16: Import Preference Support for interface**

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color and Layer</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Analysis Type | 3D - Yes  
2D - Yes - Only surface bodies in the xy plane will be imported |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Notations**

**Selective Update**  
This interface fully supports the Selective Update feature.

**Length Unit**  
The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Hidden Parts**  
Parts that are hidden, blanked or suppressed in NX are skipped automatically by this interface.

**Import CAD Color as Named Selections**  
To import an object’s Color as Named Selections in ANSYS Workbench, specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Import CAD Layer as Named Selections**  
To import objects that are assigned a Layer as Named Selections in ANSYS Workbench, specify the "Named Selections" option and set the "Named Selections Key" to "Layer" or a list of specific Layers delimited by a semicolon (for example: "Layer:0;Layer:1;Layer:3").

**Caveats and Known Issues**

**Assembly Cut.**  
NX 3 implements a new feature named "assembly cut". The Reader provides limited support for this new feature.

**Tool Body Used for “cut”**  
Reader does not distinguish between the tool body and target bodies.

**Limited Support for Assembly Attributes.**  
Translation of Hidden Attribute in assembly files is not supported. Translation of layer information in assembly files is not supported. When same sub-assembly definition is instantiated more than once and assigned different colors at each level, the Reader will translate the color combination of the first sub-assembly definition colors found. The Reader does not duplicate the same sub-assembly definitions if the sub-assembly is used multiple times.

**Limited Support for Coordinate Systems.**  
WCS present in the part files will be translated only if they are referred through Reference Sets that to be included in the assembly instances. For example, in the default 'Part' Reference Set does not contains WCS. Hence, WCS will not get translated with 'Part' Reference Sets when included in the assembly files. This matches with the NX Modeler behavior.

**Hole Feature.**  
Hole name will not match the feature name in NX. For example, in NX the feature name in a feature tree may be SIMPLE HOLE (3), however, reader outputs it as SIMPLE HOLE (1). Hole top face information is not supported. Pattern of Hole feature is not supported.
Datum Target. Orientation_Position_1 and Orientation_Position_2 values for all Datum Targets are not supported.

**Important**: Non-semantic Datum Target without datum reference is not supported. Semantic Datum Target Type Arbitrary Shape is not supported.

Name Attribute for Sketches. As for sketches, the name attached to a sketch is not translated, but the name attached to the curve or point of a sketch will be translated.

Material Properties. If a material property has multiple values, then only the first value in the table is given as the value for that property. Only isotropic materials from the NX material library are translated. In material properties, only the Unit systems available in an NX Modeler are supported. Custom Unit systems are not supported.

**Troubleshooting**

No known issues have been identified in the CAD Integration Troubleshooting (p. 119) section.

**NX Associative Geometry Interface (*.prt)**

The interface works in both a Plug-in (p. 123) and a Reader (p. 123) mode.

The existence of the Plug-in (p. 123) is recognized by NX based on the UGI\_CUSTOM\_DIRECTORY\_FILE environment variable. If the variable points to a text file, NX reads the text file and interprets each line as a directory containing a NX third party Plug-in (p. 123). NX loads the ANSYS NX geometry interface from the appropriate directory specified in the file.

In Linux, however, the plug-in mode for the ANSYS geometry interface is not supported. The reader mode uses a client-server implementation of the ANSYS NX geometry interface.

After launching NX, if the ANSYS (version specific) menu is not displayed, run the CAD Configuration Manager with NX selected for configuration (Start->Workbench->Utilities->CAD Configuration Manager in Windows or ansys_inc/v(version specific)/commonfiles/CAD/bin/linx64/Ans.CadInt.CADConfigUtility-GUI.exe in Linux).

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Linux**: Configuring CAD Products> Using the CAD Configuration Manager
- **Windows**: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Both part and assembly document import is supported.

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Table 17: Import Preference Support for UG NX geometry interface**

<table>
<thead>
<tr>
<th>Import Solids</th>
<th>Yes</th>
</tr>
</thead>
</table>

**Table 17: Import Preference Support for UG NX geometry interface**
<table>
<thead>
<tr>
<th>Feature</th>
<th>Behavior</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes — lines consumed by NX features are not imported</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - from ANSYS Named Selection Manager (p. 22) and programmatically created attributes, user attributes, colors, etc.</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes; 2D - Yes; only surface bodies in only the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes - including visible WCS</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>Yes</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes, except lines</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>Yes - for parts that include both solid and surface bodies AND the Import Solid and Import Surface preferences are set to Yes</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

**Notations**

**Tabular Material Data**  When importing tabular data for a material property, the first data point is used to complete the material definition.

**NX Color Attributes**  NX color attributes can be imported using the 'Color' key in the list of attribute or the named selection keys. Once the attribute or named selection import is enabled in the WB2 geometry properties window, append the 'Color' key in the list of keys, separated by semicolons, to import the NX color attributes. Note that, beginning with Release 14.5, the option for 'NX Color Processing' is not supported and is removed from the CAD configuration.

**Load Options**  Load options for a part can be specified during the import. The Plug-in (p. 123) will first attempt to load the options from the options file specified using the UG_LOAD_OPTIONS environment variable. If it fails, an attempt to load the load_options.def file from the part directory is made. If both the attempts fail, a third attempt is made to load the options from %HOME%\load_options.def, where HOME is an environment variable pointing to the user's home folder. See the NX documentation for more information on the usage of load options.

**Part Units in an Assembly**  All parts in an assembly must have the same unit for a successful import. Use the ug_convert_part command to convert all parts in an assembly in the same unit. To do this, launch the NX command prompt from the programs menu. For NX 11.0 the command prompt can be found in Programs > Siemens NX 11.0 > NX Tools > Command Prompt. Type 'cd< Directory>' to change to the directory containing the assembly. Run the command 'ug_convert_part -mm -d -s -y' or
'ug_convert_part -in -d -s -y', without the quotes to change the unit to millimeter or inch, respectively. See the NX documentation on the ug_convert_part command for more information.

**Using Multiple Versions of NX** If you have multiple versions of NX installed, you must make sure that the UGI_BASE_DIR and UGI_ROOT_DIR environment variables point to the correct version of NX when running the ANSYS Mechanical application in Reader (p. 123) mode.

The NX reader will use the version of NX set by these variables when processing the attach or updates. Parts files are saved in the format designated by the above two variables. In Linux, the environment variable can be set in the shell configuration file to achieve this.

**Maintaining Associativity of Persistent IDs** The object associativity is of particular importance if you update/refresh a geometry with applied loads and supports. The ANSYS NX geometry interface uses the User Defined Objects (UDO) to store persistent IDs. To maintain the associativity of the geometry between NX and the ANSYS Mechanical application, you need to save the part file at the end of a NX session (Plug-in (p. 123)), or save the NX part file from within the ANSYS Mechanical application (reader). Saving the part file from within the ANSYS Mechanical application at attach time requires that you first check the 'Reader (p. 123) mode saves updated file' checkbox under the 'Advanced Geometry Options' group on the ANSYS Workbench Project page. The part file will be saved at the end of an attach process using the same file name in the same directory. The current part file will be backed up by changing the extension of the file to bak before saving the part. Make sure that the file is not set to read-only.

If you do not save the parts files, during an update after the initial attach, the loads and supports could disappear or be applied to the wrong entities.

You should avoid setting Reader Save Part File to Yes on Linux platforms if a CAD file is open. Doing so can result in an unexpected behavior.

**Facet Smoothness Control** The geometry faceting obtained by the ANSYS NX geometry interface is view-dependent. That means the facet smoothness of the imported geometry depends on how the object is displayed on the screen. Although the default settings are generally acceptable for most of the cases, these may not be adequate for a geometry needing smoother facets. The facet smoothness in such cases can be controlled by the ANS_UG_FACET_AFFINITY environment variable.

The variable can be set to any floating point number from 1e-8 to 1e+8. The higher the value is, the finer the facet will be and the longer it will take to import the geometry. If the variable is absent or outside the acceptable range, 1.0 will be assumed as the default value for it.

*Note that this environment variable may get removed entirely or replaced by a more user friendly variation in the future release.*

**Using the Teamcenter Import** Double-click on the NX part file in the Teamcenter Portal. This will open the part file in NX. Attach the model into the ANSYS Mechanical application using ANSYS 18.2 > Workbench menu item and optionally perform one or more analyses.

Save the project archive file into the Teamcenter database using File> Save to Teamcenter in the ANSYS Workbench project page. It will prompt you for the Teamcenter user name and password and other information. Provide your credentials to check-in the project archive.

For detailed information, see CAD Integration ANSYS Teamcenter Connection (p. 103) (Workbench help> CAD Integration > ANSYS Teamcenter Connection).
Caveats and Known Issues

AIM Behavior  Attempting to start AIM from the ANSYS menu in CAD with an unsaved model will issue an exception in AIM.

Imported Body Size  All NX bodies must be within a 1000 x 1000 x 1000 meter cube, centered about the origin of the absolute coordinate system.

Initial Launch  After installation of ANSYS Workbench, importing an NX model using the Reader (p. 123) mode requires the CAD be launched one time. Otherwise, the first attempt to import will fail, but subsequent attempts will work normally.

Large Number of Named Selections  In an assembly or a part with a large number of named selections, close to about a thousand, NX might close unexpectedly when you try to add more than 10 named selections at a time in the list. To avoid the problem, add few named selections at a time, close the named selection manager and save the part. This problem does not affect a list of named selections less than about a thousand, and the workaround is not needed for such cases.

Length Unit  The ANSYS Mechanical application automatically sets the length unit in the part or assembly to match the unit saved in the NX file. No adjustment of length unit is necessary or possible.

Linux Issues  Linux uses a client-server implementation of the NX reader. Currently, there is no Plug-in (p. 123) version of the feature. For this reason, some of the features that require direct communication with NX, are not supported by the Linux version. For example, the associativity support and Teamcenter import are not available in Linux.

If a problem is observed during an import in Linux, you should use the corresponding Windows version for it. The saved project can then be opened in Linux version of the ANSYS Workbench for further processing.

Material Property Values  There are known irregularities in material property values passed from NX to ANSYS Workbench. The user should validate all material data prior to solving.

Missing BSpline Geometries in DesignModeler  Some solids, surfaces and lines containing B spline geometries may not import correctly into the DesignModeler application, but should import correctly in the ANSYS Mechanical application. Since these B spline geometries do not conform to the Parasolid standard, they do not import correctly into the DesignModeler application. Newer geometries containing Parasolid-friendly B splines can be imported into the DesignModeler application without any problem.

Mixed Unit Support  All parts and sub-assemblies should be in the same unit. Models with mixed units imported into the ANSYS Mechanical application will trigger a warning indicating the mixed unit. Note that Siemens NX and PTC Creo are the only CAD systems that can provide mixed unit assembly data correctly to ANSYS Workbench.

Multibody Parts  For multibody parts, the bodies are grouped together and placed under part node in the ANSYS Mechanical application. If the multibody part is also multi-dimensional (i.e. contains both surface and solid bodies), this may cause a meshing problem. Bodies with different dimensions in the same part cannot be meshed in ANSYS Mechanical. An assembly, instead of a multi-dimensional multibody part, can solve the problem in such cases.

Named Selection Delete Problem with Wave Linked Features  Features containing wave linked geometries may not show the correct number of named selections after some of the named selections are deleted. For example, if an "Extracted Face" feature is created from a solid body and a named selection is created containing both the geometries, deleting that named selection may not delete it from the...
list. To fix the problem, close the **Named Selection Manager (p. 22)** and update the geometry using Edit> Feature> Playback or Tools> Update> Update for external change. The named selection manager should reflect the correct number of named selections after the update.

**Parameter Update Fails Instead of Displaying a Warning Message**  
The NX plug-in performs an undo operation when it encounters an error or a warning during a parametric update. The undo operation allows the user to change the parameter back to a correct value. Please fix the error or the warning message in NX before performing a parametric update on such a part. Alternatively, set an environment variable called UGII_UPDATE_FAIL_OPTION with a value “ACCEPT” or “ACCEPT_ALL” without the quotes and unset the variable once the parameter update is done. This will allow the import to work even if there is a warning or a failure.

**Promoted and WAVE Linked Instances**  
If the instanced bodies are promoted, they will be treated as independent bodies. The algorithm to avoid duplicate copies of instanced bodies will skip promoted bodies. Thus, if there are assembly-level operations on the promoted instances, the modified bodies from those operations will get imported correctly. The same is true for WAVE linked instances as well.

**Surface Body with Thickness**  
If your NX surface body model has a thickness defined and it does not get transferred to the ANSYS Mechanical application, this could mean that you do not have an NX Scenario (Structural) license. Moreover, only the mid-surfaces created using the offset command can have thickness property and are imported correctly. Mid-surfaces created using face pair or user defined methods cannot have a thickness and cannot be imported. In addition to that, any thickness assigned on the surfaces inside the Advanced Simulation application cannot be imported in ANSYS either.

**Unique Parameters Name**  
When you transfer NX expressions/parameters into the ANSYS Mechanical application, make sure that all feature parameter names are unique within a part and all non-feature parameter names are unique within an assembly. The non-feature parameters could be from one or more components of the assembly.

**Troubleshooting**

See the **NX Errors Related to CAD Integration (p. 122)** section in **CAD Integration Troubleshooting (p. 119)** for detailed information.

**Parasolid (*.x_t, *.xmt_txt, *.x_b, *.xmt_bin)**

The application supports Parasolid files as a **Reader (p. 123)**.

See **CAD Configuration Manager (p. 22)** for usage information.

**Linux**: Configuring CAD Products> Using the CAD Configuration Manager  
**Windows**: Configuring CAD Products> Using the CAD Configuration Manager

This is a stand-alone reader that does not require an installation of the Parasolid software or a Parasolid license.

**Support**

At the time of release, detailed version support information for the **Linux (p. 5)** and **Windows (p. 7)** platforms is accessible via **Geometry Interface Support (p. 3)**.
Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** *.x_t, *.xmt_txt, *.x_b, *.xmt_bin,

**Versions:** 29.0

**Table 18: Import Preference Support for Parasolid geometry interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>Yes</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

1. Not supported in DesignModeler

**Notations**

The DesignModeler application allows neutral binary Parasolid files (x_b and xmt_bin) and text Parasolid files (x_t and xmt_txt) to be imported and exported.

Both text and neutral binary Parasolid files are platform independent.

Binary neutral Parasolid files (xmt_bin, x_b) are compressed but are not human readable.

Text Parasolid files are human readable but take up more space than their respective neutral binary versions.

The default Parasolid file setting for the DesignModeler application is text.
Faceting Limitation  Generalized (non-manifold) bodies from Parasolid will not have facets with smoothly matching edges. The model will appear to have gaps; however, this is a limitation only in the faceting capabilities from Parasolid and does not affect meshing or accuracy.

Import CAD Color as an Attribute or Named Selection

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

Length Unit  The ANSYS Mechanical application automatically sets the length unit in the part or assembly to meters, which is the unit used internally by Parasolid to dimension solid parts. No adjustment of length unit is necessary or possible.

Part and Assemblies Files  Parasolid files containing parts or assemblies are supported by the ANSYS Mechanical application. Parasolid files can use the extensions \*.x_t or \*.xmt_text (text) and \*.x_b or \*.xmt_bin (binary neutral).

Body Instancing  If the **Import Using Instances** property is enabled, then body instances will be generated in Mechanical/Meshing for any Parasolid file with body instances.

Caveats and Known Issues

No caveats or known issues.

Troubleshooting

See the Parasolid Errors Related to CAD Integration (p. 122) section in CAD Integration Troubleshooting (p. 119) for detailed information.

Rhinoceros (*.3dm)

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader, which does not require that Rhinoceros be installed to the system.
- No CAD associativity support.
- No CAD Parameters support.

The interface is always configured by the ANSYS installation.

Support

At the time of release, detailed version support information for the Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

Document import supported by interface: Assemblies and Parts (*.3dm)
Versions: Rhino (3DM) V4.0, V5.020

Table 19: Import Preference Support for Interface

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>2D</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

Notations

Selective Update  This interface fully supports the Selective Update feature.

Length Unit  You should specify the length unit of the parts retrieved from the Rhinoceros file in the Details View. You can verify length units by checking the details of the Geometry or Part, which shows the part's bounding box size. You should verify dimensions before solving. See Solving Overview.

Hidden Parts  Parts that are hidden or suppressed in Rhinoceros are skipped automatically by this interface.

Caveats and Known Issues

No caveats or known issues.

Troubleshooting

No Rhinoceros errors related to CAD Integration appear in CAD Integration Troubleshooting (p. 119).
**SketchUp (*.skp)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader, which does not require that SketchUp be installed to the system.
- No CAD associativity support.
- No CAD Parameters support.

The interface is always configured by the ANSYS installation.

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** Assemblies and Parts (*.skp)

**Versions:** SketchUp 2013, 2014, and 2015

**Table 20: Import Preference Support for Interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>2D</td>
</tr>
<tr>
<td></td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>No</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
</tbody>
</table>
Notations

Selective Update  This interface fully supports the Selective Update feature.

Length Unit  You should specify the length unit of the parts retrieved from the SketchUp file in the Details View. You can verify length units by checking the details of the Geometry or Part, which shows the part's bounding box size. You should verify dimensions before solving. See Solving Overview.

Hidden Parts  Parts that are hidden or suppressed in SketchUp are skipped automatically by this interface.

Caveats and Known Issues

No caveats or known issues.

Troubleshooting

No SketchUp errors related to CAD Integration appear in CAD Integration Troubleshooting (p. 119).

Solid Edge (*.par, *.asm, *.psm, *.pwd)

For more information, see:
- Solid Edge Reader (*.par, *.asm, *.psm)
- Solid Edge Associative Geometry Interface (*.par, *.asm, *.psm, *.pwd)

Solid Edge Reader (*.par, *.asm, *.psm)

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the Solid Edge system be installed.
- No CAD associativity support.
- No CAD Parameter support.

The interface can be configured during ANSYS installation or by using the CAD Configuration Manager. See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

Windows: Configuring CAD Products> Using the CAD Configuration Manager

Support

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).
Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** Part (*.par), Assembly (*.asm), and Sheet Metal (*.psm).

**Versions:** V18 – ST9

**Table 21: Import Preference Support for interface**

<table>
<thead>
<tr>
<th>Import Solid Bodies</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes 2D - Yes  Only surface bodies in the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>Yes</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Notations**

**Selective Update**  This interface fully supports the Selective Update feature.

**Length Unit**  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Hidden parts**  Parts that are hidden or suppressed in Solid Edge are skipped automatically by this interface.

**Import CAD Color as an Attribute or Named Selection**

- **Attribute**: specify the "Attributes" option and set the "Attributes Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

- **Named Selection**: specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").
Caveats and Known Issues

The Solid Edge Reader has the following limitations:

- **Coordinate Systems.** Translation of coordinate systems (WCS) from Solid Edge is not supported.

- **Work Planes.** Translation of work planes from Solid Edge is not supported.

- **Attributes.** Translation of User Defined Attributes, both Part level as well as Assembly level, is not supported for Solid Edge Reader.

- **Material Properties.** The Material Properties will always be in the MKS unit system irrespective of the Solid Edge file unit system. The Reader supports only part level material properties.

- **Layers.** Reading and translation of Layer information for any of the entities is not supported.

- **Colors.** Translation of assembly definition and assembly instance color is not translated.

Troubleshooting

See the Solid Edge Errors Related to CAD Integration (p. 122) section in CAD Integration Troubleshooting (p. 119) for detailed information.

Solid Edge Associative Geometry Interface (*.par, *.asm, *.psm, *.pwd)

The interface works in both a plug-in and a Pseudo-Reader (p. 123) mode. Both part and assembly document import is supported.

Solid Edge based on registry entries recognizes the existence of the plug-in. After opening a document in Solid Edge, if the **ANSYS (version specific)** menu is not displayed in the Solid Edge menu bar, check if **ANSYS (version specific)** is listed in the **Available Add-Ins** list box of the **Add-in Manager** dialog box (Applications> Add Ins> Add-In Manager). If it is listed but not checked, check the box in front of it and click **OK**. If it is not listed, run the CAD Configuration Manager with Solid Edge selected for configuration.

See **CAD Configuration Manager** (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Windows**: Configuring CAD Products> Using the CAD Configuration Manager in the **ANSYS, Inc. Windows Installation Guide**.

Support

At the time of release, detailed version support information for the **Linux (p. 5)** and **Windows (p. 7)** platforms is accessible via **Geometry Interface Support** (p. 3).

The ANSYS Solid Edge interface supports Solid Edge part, assembly and sheet metal, both in traditional and synchronous formats, and traditional weldment documents.

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See **ANSYS Platform Support**.
**Table 22: Import Preference Support for Solid Edge geometry interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solids</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>3D - Yes</td>
</tr>
<tr>
<td></td>
<td>2D - Yes - Only surface bodies in the xy plane will be imported</td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes</td>
</tr>
<tr>
<td>Smart Update</td>
<td>Yes</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>Yes</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

**Notations**

**Closed Surface**  A closed surface body will be imported as a solid body since Solid Edge considers this body as a solid.

**Interpart Copies**  The interpart copies of a part should be hidden in the part level to avoid importing it in the assembly.

**Line Body Types**  The following feature types can be imported from Solid Edge into ANSYS Workbench as line bodies:

- Key Point Curves
- Curve by Tables
- Project Curves
- Derived Curves
- Cross Curves
- Copy Construction Curves
- Contour Curves
**Simplified Model**  For a part that has a simplified model (if the model is displayed in Solid Edge), you will need to have the *Simplify* menu displayed to get the simplified model in the ANSYS Mechanical application.

**Parameters**  Parameters have limited precision associated with Solid Edge models. By default, Solid Edge only shows two digits of precision past the decimal point. Therefore when you input 41.012 for example, and refresh, the precision value will appear in ANSYS Workbench to be 41.01 after the update completes. If you increase the display precision in Solid Edge, you will then see the more precise parameter values in ANSYS Workbench.

**Selection Filter Toolbar**  A toolbar named “ANSYS Selection Filter” is available in Solid Edge to pick entities like vertex, edge and face for Name Selection creation. This toolbar becomes active only when the Named Selection Manager (p. 22) dialog is open.

**Using Named Selection**  After the Named Selection dialog box is launched from the ANSYS toolbar, the ANSYS selection filter bar will be activated. First select a filter, e.g. face filter, then select the faces with the shift key pressed. Click the *Create* button to finish creating a Named Selection with the selected faces. To modify a Named Selection, start by selecting it from the list and highlight it by clicking the *Select* button. Shift + click to add to or right click to remove from the selected faces. Click the *Replace* button to complete the modification.

**Specific to ANSYS DesignModeler**

When importing a Solid Edge assembly, make sure that no two components use the same component name. This will result in the second component being displayed on top of the first.

Part documents should contain only one body, otherwise a duplicate set of parameters and variables may be imported.

When the attributes flag is on and the DDM prefix is specified, attributes are created for each entity to allow import of motion loads.

**Specific to the Mechanical Application**

All multi-solid-body components created in Solid Edge will be transferred to the ANSYS Mechanical application as a single part containing multiple bodies.

The Part length unit within the ANSYS Mechanical application is meters independent of the unit system displayed in Solid Edge. The *Length Unit* displayed under Details of Geometry in the ANSYS Mechanical application cannot be changed.

To import motion loads from Solid Edge models to the ANSYS Mechanical application, you will need to use the motion load files generated from the same version of Solid Edge that you are running. If the load files were generated from a different version of Solid Edge, the loads will not be imported properly. When the attributes flag is on and the DDM prefix is specified, attributes are created for each entity to allow import of motion loads.

**Caveats and Known Issues**

**Active Document**  If more than one document is open in Solid Edge, the top-most document, which is the active document, will be picked by the interface as the active document.
Import Solid Edge Construction Objects Control  The Solid Edge geometry interface does not import construction objects by default. The import of construction objects can be enabled by the ANS_SE_IMPORT_CONSTRUCTION_OBJECTS environment variable. Possible values are:

0: Do not import construction objects
1: Import construction solids + surfaces + wires
2: Import construction solids + surfaces only
3: Import construction solids + wires only
4: Import construction surfaces + wires only
5: Import construction solids only
6: Import construction surfaces only
7: Import construction wires only

Note that this environment variable may get removed entirely or replaced by a more user-friendly variation in a future release.

Large Model  The import of large Solid Edge models with a maximum length over 1 kilometer cannot be imported due to Parasolid precision, that is, all parts of a body must lie inside the Parasolid size box. This box is 1000 units on each side and is centered at the origin. It represents the whole of the model space.

Multiple Named Selection Filter Menu After Changing ANSYS Language  After language setting is changed in ANSYS, multiple menu for the named selection may appear in the Solid Edge ANSYS Toolbar. To fix the problem unconfigure the plug-in using CAD Configuration Manager (p. 22) (CCM) and open Solid Edge files one of each type, such as part (*.prt), assembly (*.asm), sheet metal (*.psm) and weldment (*.pwd). Close Solid Edge and reconfigure using CAD Configuration Manager (p. 22) to fix the issue.

Plug-In Availability Considerations  Due to the architecture of the CAD’s Add-In manager, the Solid Edge geometry interface will automatically load into the Solid Edge sessions of all users when any administrative user has configured the geometry interface only to be available for their account. This is the case even when the user has not configured the geometry interface for himself/herself and a global configuration has not been performed to enable the plug-in to run for all users. When encountering such a state it may be possible to import geometry from an active Solid Edge session, but any attempts to attach or refresh geometry without Solid Edge running will fail.

When the Solid Edge plug-in is configured as part of a network install (see Using the CAD Configuration Manager) unconfiguring it on the local, client machine will (a) remove the ANSYS menu from Solid Edge, and (b) disable the ability to import geometry from an active Solid Edge session. However, import of Solid Edge models when the CAD is not active may continue to work until the interface is unconfigured on the server machine.

Unlocked Parameters for Synchronous Features  The parameters created during synchronous modeling are not locked by default. As a result the geometry cannot be modified by changing the unlocked parameters. For the same reason, any parametric modification from ANSYS would fail to generate. To fix this problem, hold the cursor on the unlocked parameter label in Solid Edge and click on the lock icon on the dialog box that pops up. Alternatively, the lock status can be modified from the Solid Edge Tools > Variables list. After locking the parameter, the geometry can be modified by changing it and can be driven by parametric update from ANSYS.

Solid Edge Part Name.  The Solid Edge plug-in uses the part name as the identifier for the associativity mechanism to work. Renaming the part after import may break the associativity. The part can be renamed in Solid Edge and refreshed to reflect the changes.
**Troubleshooting**

See the Solid Edge Errors Related to CAD Integration (p. 122) section in CAD Integration Troubleshooting (p. 119) for detailed information.

**SolidWorks (*.sldprt, *.sldasm)**

For more information, see:
- SolidWorks Reader (*.sldprt, *.sldasm)
- SolidWorks Associative Geometry Interface (*.sldprt, *.sldasm)

**SolidWorks Reader (*.sldprt, *.sldasm)**

The interface works in a Reader (p. 123) mode.

- This is a stand-alone reader which does not require that the SolidWorks system be installed.
- No CAD associativity support.
- No CAD Parameter support.

The interface can be configured during ANSYS installation or by using the CAD Configuration Manager.

See CAD Configuration Manager (p. 22) for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Windows**: Configuring CAD Products > Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support > Platform Support). See ANSYS Platform Support.

**Document import supported by interface**: Part (*.sldprt) and Assembly (*.sldasm)

**Versions**: 98 — 2017

**Table 23: Import Preference Support for interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solid Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surface Bodies</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Line Bodies</td>
<td>No</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - Color</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - Color</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----</td>
</tr>
</tbody>
</table>
| Analysis Type            | 3D - Yes  
2D - Yes- Only surface bodies in the xy plane will be imported |
| Associativity            | No  |
| Coordinate Systems       | No  |
| Work Points              | No  |
| Reader Save File         | No  |
| Instancing               | No  |
| Smart Update             | No  |
| Enclosure and Symmetry Processing | No |
| Mixed Import Resolution  | No  |
| Decompose Disjoint Geometry | Yes |

**Notations**

**Selective Update**  This interface fully supports the Selective Update feature.

**Length Unit**  The length unit specified in the part or assembly is automatically read from the geometry file and is transferred into ANSYS Workbench. The Length Unit field in the Details will be read-only. If a unit system is not detected in the geometry file, the Length Unit field in the Details will be active, allowing the Length Unit to be specified.

**Hidden parts**  Parts that are hidden or suppressed in SolidWorks are skipped automatically by this interface.

**Import CAD Color as Named Selections**  To import an object's Color as Named Selections in ANSYS Workbench, specify the "Named Selections" option and set the "Named Selections Key" to "Color" or a list of specific Colors delimited by a semicolon (for example: "Color:255.0.0; Color:255.255.0").

**Caveats and Known Issues**

**No Support for a Color Attribute assigned to an Instance of a Part or Assembly.**  Color information is read only when it is present in the B-rep data section in the .sldprt file.

**Limited Support for Reading Units in Part or Assembly Files.**  Reading unit information from SolidWorks parts of assembly files is only supported for file version Sw2001 through the latest and currently supported SolidWorks version; for earlier versions, the unit is assumed as meter. Also, unsupported units such as feetandinch and angstrom are assumed as meter.

**Material Properties**  The Reader translates material properties for part files from SolidWorks version 2012. The Material Properties will always be in the MKS unit system irrespective of the SolidWorks file unit system. The Reader supports only part level material properties.

**No Support for Assembly Features.**  Only the data in the B-rep section of a file is read.

**No Support for Attributes Show, No-Show and Hidden for Versions Prior to Sw2004.**  Attributes show, no-show and hidden are supported from version Sw 2004 through the latest and currently supported SolidWorks version.
No Configuration Support for Assemblies and Sub-Assemblies for Versions Prior to Sw98. Configuration support is present for version Sw98Plus through the latest and currently supported SolidWorks version.

No Support for Writing Actual Instance Names The reader does not supports actual instance names for separate parts and sub-assemblies in XML write.

Part Configuration Support. SolidWorks part files can contain different configurations for the same feature. Each configuration has separate geometry and topology data. The reader extracts the B-rep data stored in the “.SLDPRT” file. SolidWorks stores B-rep data corresponding to each configuration in separate streams of the “.SLDPRT” file. To support reading of configurations, reader requires the B-rep data of that configuration. Typically, a SolidWorks part file when re-saved in a higher version does not contain B-rep data for all configurations in the file. Hence, the reader cannot translate these files completely. In such cases, open the part in SolidWorks, activate each configuration and save the part.

No Support for Translation of Hidden and Suppressed Bodies/Features in Part. Reader does not support translation of hidden and suppressed bodies/features in part. Those features will simply be translated as they are ignoring their hidden or suppressed status in the part file.

No Support for Translation of Coordinate Systems.

No Support for Translation of Free Curves, Free Points or Work Planes.


Limitations

Limited Support for Virtual Assemblies The SolidWorks reader does not support pure Virtual Assemblies. To import a Virtual Assembly then the supporting parts must also be saved as part files.

Troubleshooting

See the SolidWorks Errors Related to CAD Integration (p. 122) section in CAD Integration Troubleshooting (p. 119) for detailed information.

SolidWorks Associative Geometry Interface (*.sldprt, *.sldasm)

The interface works in both a Plug-in (p. 123) and a Pseudo-Reader (p. 123) mode.

The existence of the Plug-in (p. 123) is recognized by SolidWorks based on registry entries. After opening a document in SolidWorks, if the ANSYS (version specific) menu is not displayed in the SolidWorks menu bar, check if ANSYS (version specific) is listed in the Available Add-Ins list box of the Add-in Manager dialog box (Tools> Add Ins).

If listed: but not checked, check the box in front of it and click OK.
If not listed: run the CAD Configuration Manager with SolidWorks selected for configuration (Start->Workbench->Utilities->CAD Configuration Manager). Select the ANSYS/Workbench product and then the SolidWorks interface. Click the Next button and then Configure Selected Plug-Ins. The output window should indicate success. (This requires administrative privileges on the machine.) If it fails or trouble persists, re-install the SolidWorks plug-in component or contact your technical support service representative.

See CAD Configuration Manager (p. 22) for usage information.
For detailed installation information about the CAD Configuration Manager, see:

**Windows: Configuring CAD Products > Using the CAD Configuration Manager**

**Support**

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support > Platform Support). See ANSYS Platform Support.

**Document import supported by interface:** Part (*.sldprt) and Assembly (*.sldasm)

### Table 24: Import Preference Support for SolidWorks geometry interface

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solids</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes - 3D spline curves, helix, curve in file, composite curve, ref curve, and imported curve</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes - In addition to dimension names, global variables are also processed for parameter. The same filter logic is used to determine which parameters are imported. Parameters that are driven are NOT imported.</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>Yes - From programmatically created attributes. Motion loads are imported using the preference and the corresponding third party attribute prefix.</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes - From ANSYS Named Selection Manager (p. 22) and programmatically created attributes</td>
</tr>
<tr>
<td>Material Processing</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Analysis Type                                  | 3D - Yes  
|                                               | 2D - Yes - Only surface bodies in the xy plane will be imported |
| Associativity                                  | Yes - Some data is stored in the SolidWorks model file and needs to be saved AFTER attach to maintain persistence. The Reader Save File option will need to be turned ON if imported in "reader" mode or you will need to save the file in an active SolidWorks session otherwise. The associative mechanism consumes a good part of the attach/update time when importing models from SolidWorks. If associativity is not necessary turning this option off will typically speed up the import/refresh time substantially, especially on larger models. The use of named selections can also be used as a persistence mechanism and does not require the associativity option be turned on. |
| Coordinate Systems                             | Yes - Part and assembly local coordinate systems |
| Work Points                                     | Yes - Part and assembly local work points |
| Reader Save File                                | Yes     |
| Instancing                                      | No      |
| Smart Update                                    | No      |
| Enclosure and Symmetry Processing               | No      |
**Notations**

The SolidWorks geometry interface also fully supports the **Selective Update** feature.

ANSYS Workbench automatically locks the length unit in the part or assembly to meters, which is the unit used internally by SolidWorks. No adjustment of length unit is necessary or possible. The ANSYS **Mechanical application** user can change the unit system for display of the ANSYS Mechanical application data.

Parts that are hidden or suppressed in SolidWorks are skipped automatically by the geometry interface.

If more than one document is open in SolidWorks, the top-most document, which is the active document, will be processed by the interface.

Lightweight components (marked with a feather icon in the feature tree) of a SolidWorks assembly must be set to resolved prior to attaching into the ANSYS **Mechanical application**.

**Caveats and Known Issues**

There is a limitation imposed by SolidWorks in relation to geometry and the API processing; if a sketch is revolved 180 degrees, the faces generated on either portion of the revolution are identified as the same. However if the revolution angle is changed, they now become different faces; one retains the original identification and the second a new one. This creates an associativity break if the angle of revolution is modified to or from 180 degrees. If this situation arises you will need to reapply loads and/or boundary conditions.

Databases in which loads and/or boundary conditions are attached to surface body part entities are subject to a loss of associativity if created and saved prior to release 12.0. Once the loads are reattached, associativity should be maintained.

Unsaved SolidWorks geometry files are not supported for import.

**Plug-In Availability Considerations** A scenario can occur where Attach/Refresh Geometry from active SolidWorks session works correctly, however Attach/Refresh Geometry without SolidWorks running fails with "Geometry Interface Not Found."

This can occur if you run the **CAD Configuration Manager (p. 22)** as Administrator, and select Configuration Actions apply to: Current User.

The architecture of the CAD's Add-In manager will however display the ANSYS plug-in for All Users of the machine, even if the "All Users" configuration has not been performed to enable the plug-in to run for all users. If this is done, the current user configuration of ANSYS Workbench is not made aware of the SolidWorks file types, and the interface is not found.

**Workaround:** Run the **CAD Configuration Manager (p. 22)** as Administrator, select "All Users", and configure the SolidWorks plug-in.
**Limitations**

**Global Parameters**  Global parameters that contain only numeric data in the equation field are processed. Equations which include units are skipped.

**Troubleshooting**

See the *SolidWorks Errors Related to CAD Integration (p. 122)* section in *CAD Integration Troubleshooting (p. 119)* for detailed information.

**SpaceClaim (*.scdoc)**

For more information, see:

- SpaceClaim Associative Plug-In (p. 99)
- CAD Integration SpaceClaim (p. 111)

**Caveats and Known Issues**

**Units Usage**  The units defined in the ANSYS Workbench project schematic's Unit System Dialog are not used in SpaceClaim. SpaceClaim will always transfer model data in meter units.

**SpaceClaim Associative Plug-In**

The SpaceClaim geometry interface supports SpaceClaim Engineer; and with SpaceClaim Direct Modeler on the Windows 64-bit operating system.

See *CAD Configuration Manager (p. 22)* for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Windows**: Configuring CAD Products> Using the CAD Configuration Manager

**Support**

At the time of release, detailed version support information for the Linux (p. 5) and Windows (p. 7) platforms is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See ANSYS Platform Support.

**Document import supported by interface**: Part (*.scdoc)

**Table 25: Import Preference Support for SpaceClaim geometry interface**

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solids</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>Yes</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### File Format Support

<table>
<thead>
<tr>
<th>Material Processing</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analysis Type</td>
<td>3D - Yes  2D - Yes</td>
</tr>
<tr>
<td>Associativity</td>
<td>Yes</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>Yes</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>Yes</td>
</tr>
<tr>
<td>Instancing</td>
<td>Yes — Workbench supports instances among parts that are represented by proper rigid transformations; that is, transformations which preserve the size, shape, and handedness of the part. Reflective or mirrored transformations are not supported.</td>
</tr>
<tr>
<td>Smart Update</td>
<td>Yes</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>Yes (See Caveats and Known Issues section below)</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>Yes</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

### Caveats and Known Issues

**Enclosure and Symmetry Processing**  In SpaceClaim you can create volume extraction bodies and enclosure bodies. These are transferred independent of the “Enclosure and Symmetry Processing” setting. If you do not want them to be transferred, you can hide them in SpaceClaim.

**Instancing Support**  While SpaceClaim supports transformations of reflected or mirrored geometry, ANSYS Workbench does not support it. The user is advised to remove the instancing relationships among reflected components in SpaceClaim before the geometry is imported in ANSYS Workbench.

**STEP (*.stp, *.step)**

See **CAD Configuration Manager (p. 22)** for usage information.

For detailed installation information about the CAD Configuration Manager, see:

- **Linux**: Configuring CAD Products> Using the CAD Configuration Manager
- **Windows**: Configuring CAD Products> Using the CAD Configuration Manager

### Support

At the time of release, detailed version support information for the **Linux (p. 5)** and **Windows (p. 7)** platforms is accessible via **Geometry Interface Support (p. 3)**.

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support> Platform Support). See **ANSYS Platform Support**.
Document import supported by interface: *.stp, *.step

Table 26: Import Preference Support for STEP geometry interface

<table>
<thead>
<tr>
<th>Feature</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>Import Solids</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Surfaces</td>
<td>Yes</td>
</tr>
<tr>
<td>Import Lines</td>
<td>Yes</td>
</tr>
<tr>
<td>Parameter Processing and prefix/suffix key</td>
<td>No</td>
</tr>
<tr>
<td>Attribute Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Named Selection Processing and prefix</td>
<td>No</td>
</tr>
<tr>
<td>Material Processing</td>
<td>No</td>
</tr>
<tr>
<td>Analysis Type</td>
<td>Yes</td>
</tr>
<tr>
<td>Associativity</td>
<td>No</td>
</tr>
<tr>
<td>Coordinate Systems</td>
<td>No</td>
</tr>
<tr>
<td>Work Points</td>
<td>No</td>
</tr>
<tr>
<td>Reader Save File</td>
<td>No</td>
</tr>
<tr>
<td>Instancing</td>
<td>No</td>
</tr>
<tr>
<td>Smart Update</td>
<td>No</td>
</tr>
<tr>
<td>Enclosure and Symmetry Processing</td>
<td>No</td>
</tr>
<tr>
<td>Mixed Import Resolution</td>
<td>No</td>
</tr>
<tr>
<td>Decompose Disjoint Geometry</td>
<td>No</td>
</tr>
</tbody>
</table>

Notations

You cannot import STEP files containing models with bounding box greater than 500 cubic meter in any direction from world origin even with "Enable Large Model Support" option turned on. For STEP imports to be successful the model must fit inside the base 1 km^3 size box.

Specific to ANSYS DesignModeler

The STEP (STandard for the Exchange of Product model data) reader will both read and write model data to and from the STEP format. It is important to note that the STEP format does not store model data in the same way as the DesignModeler application. STEP format stores surface data, which upon import into the DesignModeler application is stitched together to form bodies. In some rare cases, the DesignModeler application model exported to STEP format may not produce the exact same geometry when imported again into the DesignModeler application.

Specific to ANSYS Mechanical

Closed faces and hollow solids from an STEP file are transferred as full solids in the ANSYS Mechanical application.

Part and Assemblies Files  STEP files containing parts or assemblies are supported by the ANSYS Mechanical application. STEP files can use the extensions .step or .stp.

Length Unit  The ANSYS Mechanical application automatically sets the length unit in the part or assembly to meters. No adjustment of length unit is necessary or possible.
Caveats and Known Issues

No caveats or known issues.
CAD Integration ANSYS Teamcenter Connection

Teamcenter Connection

Teamcenter can be configured using the CAD Configuration Manager during installation. The Teamcenter installation from this location is used by the ANSYS Teamcenter connection to check-in the project. To check-in a project into Teamcenter, select File > Save To Teamcenter option on the project window. If this option is not available on the File menu, you might not have an ANSYS Teamcenter connection license.

Support

At the time of release, detailed version support information for the Windows (p. 7) platform is accessible via Geometry Interface Support (p. 3).

Information about post-release CAD system compatibility with ANSYS Workbench is viewable via the ANSYS, Inc. website (Support > Platform Support). See ANSYS Platform Support.

Notations

Creating ANSYS Dataset Type for Teamcenter Unified  
The Business Modeler deployment package can be used for installing the ANSYS dataset definition in the Teamcenter Unified server. The package is located in ansys_inc\v(version specific)\aisol\CADIntegration\Teamcenter\anstcpackage for Teamcenter 8.x and anstcpackage09x for Teamcenter 9.x. Copy this package to the Teamcenter Unified server where you need to install the dataset. Start the Teamcenter Environment Manager (tem) from the start menu programs list. In the Environment Manager wizard, select 'Perform maintenance on an existing configuration' and select your configuration. Select 'Add/Remove Features' on the 'Feature Maintenance' window. Click the 'Browse' button on the 'Select Features' window and select the 'feature_ansysworkbench.xml' from the anstcpackage or anstcpackage09x copied earlier. Select 'ANSYSWorkbench' under the 'Extensions' list. Proceed with the default option for the rest of the wizard. After the installation is complete, you can now start using the Teamcenter plug-in. For more information on installing a template, refer to the Teamcenter Business Modeler IDE help documentation on 'Installing a Template using TEM'.
Dataset Type Creation Frequency  The dataset type creation is needed only once and must be created on all the Teamcenter servers you need to work with. Also, if you already have a dataset type installed you don't need to install it again for a new version of ANSYS.

Operations  The output text box lists all the output generated during the Teamcenter check in process.

To start the check in process click the "Start" button. After the archiving operation is complete, the dialog box will close, allowing you to continue to work on the project. Once the process is complete it will post message in the messages panel in Workbench.

You can close the ANSYS Teamcenter Connection by clicking the "Exit" button.

Saving Project  A new project can be saved into Teamcenter using the "Add" option.

To revise a saved project, double click the dataset in Teamcenter to open the project in ANSYS 18.2. Make any necessary changes and click save on the project page to save the project. Since Teamcenter monitors for changes in any open dataset, simply saving the project will check in the project into Teamcenter.

Alternatively, the "Revise" option can also be used to revise a dataset.
Login Tab

The login tab contains the following fields:

- **User**: The user name for the Teamcenter login. This must be provided for the check in to be successful.
- **Password**: The password for the Teamcenter login. This must be provided for the check in to be successful.
- **Group**: The optional group name for the Teamcenter login.
- **Role**: The optional user role for the Teamcenter login.
- **Server**: Select one of available Teamcenter servers from the specified installation.
Dataset Tab

The dataset tab contains the following fields:

**Item name**: The item name under which the dataset should be checked in. This is optional. If no item name is provided and "Add" is selected in the option the dataset will be created.

**Item revision**: The item revision number for the item specified. Item revision is optional, but it must be provided if item is specified.

**Sequence**: Optional, user defined sequence number for the dataset. It is used to identify the multiple copies of the same dataset.

**Dataset name**: The dataset name used for the check in. This is auto-generated by the ANSYS Teamcenter Connection. To override, simply enter your preferred name. The maximum length of the Dataset name is 32 characters.

**Dataset revision**: Options for dataset revision. This contains the following choices: Add and Revise. The "Revise" option is the default if the project contains one or more imported geometry from NX-Teamcenter connection. Otherwise, the first option is default.

**Description**: The optional text entered in the Description field will appear in the Teamcenter object description. Maximum length of text is 240 characters.
Archive Tab

During the check in process a copy of the archived project is checked in.

The Archive options are recognized as follow:

The first three options can be used to control what files will be archived together for the check in. The less items you pick, the smaller the file size will be.

If your project needs to be repaired, the archive operation will not succeed. To force the archive operation in such cases, select the "Archive project, even if it needs to be repaired " option.

If you opened an already archived project (WBPZ files), either from the disk or directly from Teamcenter, all you changes will get saved into the archived project. In this case you do not need to archive it again during the check in. But if you prefer, you can force the archive operation by selecting the "Archive project again, even if it is already archived " option.
Persistent Fields  The following fields in the Teamcenter check in window are persistent between sessions. They are saved upon exit from the dialog and retrieved during startup. These options are 'Item', 'Item Revision', 'Sequence', 'Description', 'Group', 'Volume', 'Dataset Revision', and 'Selected Server'.

Combination of Different Dataset Revision Options and Item Name  There are two dataset revision options:

- Add, and
- Revise

After specifying the dataset option you can either specify an item name or leave it blank. The item you specified may or may not exist in Teamcenter.

These options produce a combination of six usable cases. What happens for each of these cases are enumerated below.

CASE 1  *Item*: specified and exists, *Dataset Option*: Add

- The dataset will be created under the item name. If there is already a copy of the dataset, a new copy will get created.

CASE 2  *Item*: specified but does not exist, *Dataset Option*: Add

- The dataset will be created under the "Newstuff" (2–Tier). If there is already a copy of the dataset, a new copy will get created.

- For 4–Tier, a new item with the given item name will be created under the home directory.

CASE 3  *Item*: not specified, *Dataset Option*: Add

- See case 2.

CASE 4  *Item*: specified and exists, *Dataset Option*: Revise

- The dataset will be created under the item name. If there is already a copy of the dataset, the copy will get revised.

CASE 5  *Item*: specified but does not exist, *Dataset Option*: Revise

- A new item with the specified item name will get created in the "Newstuff" (2–Tier) or “Home” (4–Tier) directory first. The dataset will be created under this newly created item name.

CASE 6  *Item*: not specified, *Dataset Option*: Revise

- This case does not work. The interface will ask if the Add option should be selected instead. If you choose 'Yes', the Add options get selected and case 3 executes.

Teamcenter Discriminator  A unique identifier can be used to grant or revoke the access to the Teamcenter server for the ANSYS SOA application. This can be set by running the CAD Configuration Manager (p. 22) (CCM).
Caveats and Known Issues

Description for Revised Dataset in 2-Tier    Due to a limitation in the Teamcenter check-in process for 2-Tier, the description is not updated when an ANSYS dataset is revised. This problem does not appear for the 4-Tier plug-in.

License requirements    ANSYS Teamcenter connection license is needed for the ANSYS Teamcenter check-in. Only the ANSYS UG plug-in license is needed for import of active Teamcenter NX geometry.

Teamcenter Installation    During install CAD Configuration Manager (p. 22) (CCM) asks for Teamcenter installation directory and creates either TC_ROOT or IMAN_ROOT depending on Teamcenter version. If both TC_ROOT and IMAN_ROOT are defined TC_ROOT will be used. The install location will be saved in the registry during the first run and will be used subsequently, ignoring the environment variable.

ANSYS Session from Teamcenter    When ANSYS is launched from Teamcenter, either directly by opening an ANSYS dataset from Teamcenter or from an NX manager session initially spawned from Teamcenter, it will obtain the environment variables values from that Teamcenter sessions. Make sure that the environment variable values are set to the expected values if you have any trouble with the ANSYS Teamcenter Connection.

Finding the Checked in Dataset    If your item exists select the item node and click refresh to see the checked in item. Also, you can refresh the “newstuff” (2-Tier) or “home” (4-Tier) folder for finding the dataset.

FMS_HOME    Make sure your FMS_HOME points to the correct version of Teamcenter. Also, make sure you can check in a part file from NX, before you try to check in the part from ANSYS.

Length of Dataset Name    Teamcenter allows only 32 characters or less for the dataset name and item names. Sometimes for larger item name the auto-generated dataset name may exceed 32 characters. Rename the dataset name manually from the options page to avoid the problem.

Length of the Description    The length of the description must not exceed 240 characters.

New Item Creation with Empty Names in Teamcenter 9.1    A check-in with an empty or new item name may fail with Teamcenter 9.1. In such case, ANSYS may incorrectly report success. To avoid this problem, please create a new item in Teamcenter 9.1 and use this name during the check-in. This problem does not affect the Teamcenter 10.1 and Teamcenter 9.1.3 on Windows 8.1.

Project Archive Size    The project file size can grow quickly during a ‘solve’ in ANSYS. It can slow down the check in process. Use the archive options carefully to include/exclude results, external files and user files to resolve the issue.

Also, you can save a copy of the project locally before the solve operation and check in the project once the work is done. In this way, the slow save process over the network can be avoided during the intermediate save operations.

Teamcenter Rich Client Install    The current implementation of the ANSYS Teamcenter plug-in (p. 123) only works with a 2-tier or a 4-tier rich client install. Over the Web (OTW) or any other type of Teamcenter installation will not work with the plug-in.
**CAD Integration SpaceClaim**

ANSYS SpaceClaim Direct Modeler (SCDM) is available in ANSYS Workbench. Unlike ANSYS DesignModeler which is a history-based parametric application, SpaceClaim Direct Modeler is a direct modeling application. Access and use of SpaceClaim Direct Modeler requires you have an existing SpaceClaim Direct Modeler license.

**SpaceClaim** topics:

- Import Procedure (p. 111)
- Importing External CAD Files into SpaceClaim Direct Modeler (SCDM) using ANSYS Workbench (p. 111)
- Importing SpaceClaim Geometry into DesignModeler (p. 112)
- Starting SpaceClaim before ANSYS Workbench (p. 112)
- Starting ANSYS Workbench before SpaceClaim (p. 113)
- Importing SpaceClaim Geometry into Mechanical APDL (p. 113)
- Limitations (p. 113)

**Import Procedure**

You can select your preferred geometry editor in the Options panel via the Tools menu in ANSYS Workbench. Select Geometry Import.

SpaceClaim Direct Modeler allows you to import a clean instance of a 3D model from a CAD system without history-based parameters. However you cannot conduct a parametric study using the same parameters that are defined in the native CAD model, and after an analysis, update the model through the same set of parameters automatically.

Within the ANSYS Workbench environment, four options exist for SpaceClaim depending when the work flow commences.

- Importing External CAD Files into SpaceClaim Direct Modeler (SCDM) using ANSYS Workbench (p. 111)
- Importing SpaceClaim Geometry into DesignModeler (p. 112)
- Starting SpaceClaim before ANSYS Workbench (p. 112)
- Starting ANSYS Workbench before SpaceClaim (p. 113)

**Importing External CAD Files into SpaceClaim Direct Modeler (SCDM) using ANSYS Workbench**

1. Start ANSYS Workbench
2. Create empty geometry cell.
3. Right click on geometry cell and select Import Geometry->Browse. Specify the CAD file name in the file open dialog.
4. Make sure the geometry file name is set in the geometry cell properties.

5. Right click on geometry cell and select “Edit Geometry in SpaceClaim”

**Importing SpaceClaim Geometry into DesignModeler**

---

**Note**

You do not need to close a running instance of SpaceClaim Direct Modeler to import SpaceClaim geometry into ANSYS DesignModeler.

---

1. Launch "SpaceClaim Direct Modeler":

2. Open an existing .scdoc file (or) create geometry in SpaceClaim and save into a .scdoc file.

3. Launch ANSYS Workbench.

4. Create a new Geometry system in Project Schematic.

5. Launch ANSYS DesignModeler using the right mouse button on the Geometry cell; select **New Design-Modeler Geometry**.

6. Inside ANSYS DesignModeler, select the menu item **File->Attach to Active CAD Geometry**. The "Source" property of Attach feature should be set to the .scdoc file.

7. Click the **Generate** button. The SpaceClaim geometry is imported into ANSYS DesignModeler.

The following steps can be used to bring SpaceClaim geometry into ANSYS DesignModeler using the SpaceClaim Plug-in (p. 123). The following steps will not use SpaceClaim Add-in.

**Starting SpaceClaim before ANSYS Workbench**

In this scenario, ANSYS Workbench is started using the SpaceClaim menu item, either ANSYS SpaceClaim Direct Modeler or SpaceClaim Engineer.

### Using ANSYS SpaceClaim Direct Modeler

If geometry in ANSYS SpaceClaim Direct Modeler is not saved to a .scdoc file:

1. Start ANSYS SpaceClaim Direct Modeler and create geometry, but do not save.

2. Starting ANSYS Workbench using the 18.2 button in the Prepare tab will create a geometry system in the project schematic.

3. The “geometry file name” property of the geometry cell will be empty.

4. The "CAD Plug-in" property will be set to "SpaceClaim[]" if geometry in SpaceClaim Direct Modeler is not saved in to a .scdoc file.

5. As soon as ANSYS Workbench is started, the SpaceClaim Direct Modeler editor will behave in add-in mode and the you can transfer geometry to Mesh/Mechanical.

### Using ANSYS SpaceClaim Direct Modeler

For saved .scdoc file:
1. If geometry in ANSYS SpaceClaim Direct Modeler is saved to a .scdoc file before starting ANSYS Workbench, then the “geometry in name” property is set to the saved .scdoc file name.

2. As soon as ANSYS Workbench is started, the SpaceClaim Direct Modeler editor will behave in add-in mode and you can transfer geometry to Mesh/Mechanical.

**Using SpaceClaim Engineer** you should save the geometry in SpaceClaim Engineer to a .scdoc file before starting ANSYS Workbench.

For a saved scdoc file:

1. If the geometry in SpaceClaim Engineer is saved into a scdoc file before starting ANSYS Workbench, then "geometry file name" property is set to the saved scdoc file name and "CAD Plug-in" property as "SpaceClaim[]".

2. You can transfer geometry to mesh/mechanical.

**Starting ANSYS Workbench before SpaceClaim**

In this scenario, SpaceClaim is started using the ANSYS Workbench menu item.

1. Start ANSYS Workbench
2. Create empty geometry cell.
3. Start SpaceClaim Direct Modeler and create geometry.
4. If you do not save the geometry into .scdoc file, user could not attach geometry.
5. To attach the geometry, save the geometry to a .scdoc file.
6. If you attach a saved .scdoc file in the geometry cell, the SpaceClaim Direct Modeler editor will behave in add-in mode.

**Importing SpaceClaim Geometry into Mechanical APDL**

1. Start ANSYS Workbench.
2. Create an empty geometry cell.
3. Right click on the geometry cell and select Import Geometry -> Browse to assign a .scdoc file or external CAD file.
4. Edit the geometry in SpaceClaim Direct modeler if required.
5. Establish a downstream connection to a Mechanical APDL cell.
6. Refresh the Mechanical APDL cell to execute a transfer from SpaceClaim Direct Modeler as an exported .anf file.

**Limitations**

SpaceClaim support for prior versions of Workbench is limited to ANSYS 15.0 or newer.

**Related Topics:**

- Release 18.2 - © ANSYS, Inc. All rights reserved. - Contains proprietary and confidential information of ANSYS, Inc. and its subsidiaries and affiliates.
SpaceClaim Side-by-side Configurations

ANSYS Workbench 17.0 now allows multiple versions of SpaceClaim products to be installed on the same machine. The CAD Configuration Manager utility offers advanced support for configuring how SpaceClaim links with ANSYS Workbench. ANSYS Workbench 17.0 supports two forms of side-by-side configurations for SpaceClaim products.

ANSYS SpaceClaim Direct Modeler Side-by-side

ANSYS SpaceClaim Direct Modeler was integrated into the ANSYS Workbench installation starting with version 16.0. ANSYS Workbench’s side-by-side support now includes the ANSYS SpaceClaim Direct Modeler component.

The ANSYS SpaceClaim Direct Modeler included in the 17.0 installation can only be configured to link with the 17.0 Workbench components. Links to prior versions of Workbench are no longer supported.

SpaceClaim Engineer Side-by-side

SpaceClaim Engineer installations can be installed side-by-side with ANSYS SpaceClaim Direct Modeler. The CAD Configuration Manager provides the ability to configure the SpaceClaim link to ANSYS Workbench 17.0.

The CAD Configuration Manager utility will present the configuration options according to the supported versions it detects. Support for configuring SpaceClaim Engineer will only be visible in the CAD Configuration Manager utility if a valid ANSYS Workbench 17.0 connection plugin is detected within its installation.

---

**Note**

Only one SpaceClaim product can be configured with ANSYS Workbench at a time.

---

**Note**

If SpaceClaim Engineer is installed prior to the ANSYS Workbench installation and the CAD Configuration Manager utility can detect a supported connection plugin it will be automatically configured to be active.

---

SpaceClaim Pre-16.1 Installation Guidelines

ANSYS SpaceClaim Direct Modeler is now part of the ANSYS Workbench installation and requires configuration changes when versions prior to Workbench 16.1 or other SpaceClaim products (standalone ANSYS SpaceClaim Direct Modeler, SpaceClaim Engineering) are installed or will be installed on the same machine.
**SpaceClaim Products Installed Prior to Workbench 16.0 Installation**

ANSYS SpaceClaim Direct Modeler will not be configured during installation of Workbench if a previous installed version of SpaceClaim Direct Modeler or SpaceClaim Engineering is detected.

If desired, ANSYS SpaceClaim Direct Modeler can be configured manually, following the removal of previously installed versions.

To configure manually, execute the AnsConfigSpaceClaim.exe from the following ANSYS installation location: `<INSTALL_PATH>\common files\configs\winx64\config\`

**Linking Workbench 15.0 with the SpaceClaim 16.0 Installation**

The ANSYS SpaceClaim Direct Modeler included in the 16.0 installation can be configured to interface with Workbench 15.0 if no other SpaceClaim products are installed. To establish the link, execute the SCDMConnect.exe from the following ANSYS installation location: `<INSTALL_PATH>\scdm\`

---

**Note**

ANSYS SpaceClaim Direct Modeler 16.1 cannot be linked to prior versions of ANSYS Workbench.

---

**SpaceClaim Products Installed After Workbench 16.0 Installation**

All SpaceClaim products released with and after the Workbench 16.0 release have installation support that will automatically unconfigure the 16.0 version of SpaceClaim Direct Modeler. This will override the Workbench 16.0 installation and allow the SpaceClaim product to assume the linked connection with Workbench.

**Known Issues and Limitations**

- The 16.0 version of SpaceClaim Direct Modeler is not compatible with Workbench versions prior to 15.0. Use of SpaceClaim Direct Modeler with Workbench versions prior to 15.0 requires SpaceClaim Direct Modeler 2014 SP2.

- Installing SpaceClaim products released prior to Workbench 16.0 is not supported. Doing so will result in unexpected behaviors. The 16.0 version of SpaceClaim Direct Modeler can be disabled to allow prior versions of SpaceClaim products to assume the linked connection to Workbench by executing AnsUnconfigSpace-
Claim.exe from the following ANSYS installation location: <INSTALL_PATH>\common files\configs\winx64\un-config\n
**Note**

Once the 16.0 version of ANSYS SpaceClaim Direct Modeler has been unconfigured, prior SpaceClaim product versions can be installed/re-installed.

**Note**

All SpaceClaim Engineering products released with or after Workbench 16.0 have modified their installations to automatically unconfigure the 16.0 version of ANSYS SpaceClaim Direct Modeler if it is detected.

**ANSYS SpaceClaim Direct Modeler (SCDM) Behavior in the Project Schematic**

Within the ANSYS Workbench help there is detailed information about using ANSYS SpaceClaim Direct Modeler in the ANSYS Workbench Schematic at:

  Configuring ANSYS Workbench> Setting ANSYS Workbench Options> Geometry Import Systems> Component Systems> Geometry

See the Workbench User’s Guide for complete information about the ANSYS Workbench interface.

**Note**

A geometry cell can be edited by one editor at a time (either ANSYS DesignModeler or ANSYS SpaceClaim Direct Modeler).
CAD Integration Frequently Asked Questions

See the Geometry Interfaces section via the Products tab of the ANSYS website for a list of On Demand webinars related to CAD integration.

The ANSYS Knowledge Resources section of the ANSYS Customer Portal includes a database of frequently asked questions for such general topics as CAD Connections. Listed under the Online Support heading on the ANSYS Customer Portal, the ANSYS Knowledge Resources section also includes best practices and examples.
CAD Integration Troubleshooting

Categorized below by CAD systems is a list of error messages and the cause of the error. The ANSYS Knowledge Base (accessible via the ANSYS Customer Portal) allows you to perform solution and defect searches. You must register and create a password to access the ANSYS Customer Portal via the ANSYS website (www.ANSYS.com).

**Solutions Search:** The ANSYS Solutions Search allows you to search the ANSYS Knowledge Base for a wide variety of technical topics. The Knowledge Base is continuously updated by the support organization with new solutions, best practices, examples, etc.

**Defects Search:** The ANSYS Defect Search allows you to search the help defects files for selected ANSYS, Inc. products.

To view the ANSYS Knowledge Resources, navigate to Online Support> Knowledge Resources on the ANSYS Customer Portal.

- General Errors Related to CAD Integration
- ACIS Errors Related to CAD Integration
- Autodesk Inventor Errors Related to CAD Integration
- CATIA Errors Related to CAD Integration
- Creo Parametric Errors Related to CAD Integration
- NX Errors Related to CAD Integration
- Parasolid Errors Related to CAD Integration
- Solid Edge Errors Related to CAD Integration
- SolidWorks Errors Related to CAD Integration

**General Errors Related to CAD Integration**

For further clarification of errors listed below, contact ANSYS Technical Support. More information about ANSYS Technical Support and Technology Enhancements and Customer Support (TECS) is available via the ANSYS Customer Portal. You must register and create a password to access the ANSYS Customer Portal via the ANSYS website (www.ANSYS.com).

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>The required license is unavailable.</td>
<td>Plug-in license was not able to be checked out.</td>
</tr>
<tr>
<td>Assemblies not licensed.</td>
<td>User attempting to attach an assembly model, but did not purchase or properly configure assembly licensing.</td>
</tr>
<tr>
<td>Cannot open part file.</td>
<td>If call to CAD to open model file fails this message is displayed.</td>
</tr>
<tr>
<td>Unable to retrieve part.</td>
<td>Part model is wireframe model in UG.</td>
</tr>
<tr>
<td>No model is currently active.</td>
<td>The CAD system has no model open.</td>
</tr>
<tr>
<td>Unable to acquire part data.</td>
<td>Query of CAD part data returned failure message.</td>
</tr>
<tr>
<td>Assembly has no parts.</td>
<td>An assembly model has no parts or all have been suppressed.</td>
</tr>
<tr>
<td>Unknown entity.</td>
<td>CAD identifies model element as a type unknown to plug-in.</td>
</tr>
<tr>
<td>Registration access error.</td>
<td>Attempt to read information for system registry returned error.</td>
</tr>
</tbody>
</table>
### CAD Geometry Fails to Import

If you attempt to import geometry and the Plug-in (p. 123) or Reader (p. 123) fails to load properly or the geometry fails to load, or if DesignModeler fails to start, the CAD configuration may not have been completed properly during the ANSYS Workbench installation process. Although the product installation and CAD configuration steps can be done as a non-administrative user, administrative rights are required to fully configure several ANSYS CAD products, including the ANSYS Workbench Plug-Ins for Autodesk Inventor (*.ipt, *.iam) (p. 38), Creo Elements/Direct Modeling, Solid Edge, and SolidWorks. NX in Reader (p. 123) mode also requires administrative rights to configure. If these products were not configured as administrator, the registration may not have completed properly and you could see CAD-related errors. See Using the CAD Configuration Manager in the ANSYS, Inc. Windows Installation Guide for detailed information on configuring these CAD products properly.

If you ran a silent prerequisite installation, you may need to reboot your machine to complete the prerequisite installation before you can successfully import a geometry.

### ACIS Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unable to initialize (ACIS or Parasolid) libraries.</td>
<td>Current file structure has missing or erroneous elements.</td>
</tr>
<tr>
<td>File does not exist.</td>
<td>Entered file does not exist.</td>
</tr>
<tr>
<td>Failed to read the (ACIS or Parasolid) file.</td>
<td>File is corrupt.</td>
</tr>
<tr>
<td>No valid bodies found in the file.</td>
<td>No valid geometry found in file to import.</td>
</tr>
</tbody>
</table>
## Autodesk Inventor Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Failed to get reference key.</td>
<td>Unable to get reference data from Autodesk Inventor (*.ipt, *.iam) (p. 38). Not a fatal error. The attach process continues, but an associative relation during update cannot be guaranteed.</td>
</tr>
<tr>
<td>Attach failed.</td>
<td>Attach aborted.</td>
</tr>
</tbody>
</table>

## CATIA Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Error</td>
<td>Current file structure has missing or erroneous elements.</td>
</tr>
<tr>
<td>File is not a CATIA export file</td>
<td>The ANSYS Mechanical application can import only CATIA export type files, the entered file is not of that type.</td>
</tr>
</tbody>
</table>

## Creo Parametric Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>The CAD model regenerated successfully, but some features are unattached.</td>
<td>One or more Creo Parametric model feature became unattached either prior to or as result of parametric change and regeneration initiated by Workbench Plug-In.</td>
</tr>
<tr>
<td>Unable to select one or more items from selection, possible corrupted WB parameters within Pro/E model.</td>
<td>The ANSYS Workbench Plug-In stores named selection data as Creo Parametric Model Parameters with prefix WBNS or WBAC. When this message is displayed the Named Selection Manager (p. 22) likely failed to complete the specified add, remove or rename operation because one of these parameters was modified or deleted.</td>
</tr>
<tr>
<td>Unable to delete one or more items from selection, possible corrupted WB parameters within Pro/E model.</td>
<td>Unable to rename one or more items from selection, possible corrupted WB parameters within Pro/E model.</td>
</tr>
<tr>
<td>Cannot activate different model with same name as model in session.</td>
<td>User is attempting to activate a model of the same name and different path when attaching models in the ANSYS Mechanical application.</td>
</tr>
<tr>
<td>Entered non-integer value for XXX Truncating value.</td>
<td>When changing the value of a parameter in the ANSYS Mechanical application, if the originally defined parameter is of integer type and you enter a non-integer value this message will be displayed as a reminder for future updates.</td>
</tr>
<tr>
<td>Warning: Pro/E Asm does not use consistent unit system.</td>
<td>A component part does not have the same unit system as the assembly. This is a requirement as indicated in the documentation. The component name is visible in the progress window at the time this error occurs. You are advised to terminate the attach (by clicking Cancel in the progress window) and returning to Creo Parametric to bring all components of the model to the same unit system. If you wish, you may allow the attach to continue to its completion making note of all components that generate this warning, then return to Creo Parametric to make changes. In some instances only the...</td>
</tr>
</tbody>
</table>
### Troubleshooting

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>assembly needs to be modified instead of the parts. If allowed to import entirely, the model is likely to have graphics and selection problems. These will be remedied when the model is imported after changes are made to the Creo Parametric model.</td>
<td></td>
</tr>
</tbody>
</table>

### NX Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Could not lock NX.</td>
<td>NX is already locked by some other process</td>
</tr>
<tr>
<td>Could not unlock NX.</td>
<td>If the ANSYS Mechanical application did not successfully lock NX, this unlock error is also likely to be displayed as it does not have the right to unlock NX.</td>
</tr>
</tbody>
</table>

### Parasolid Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schema access error.</td>
<td>Probably saved model in later version of Parasolid or schema directory is missing.</td>
</tr>
</tbody>
</table>

### Solid Edge Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Workbench Plug-In disabled.</td>
<td>Plug-in has been disabled and unable to be used for attach process.</td>
</tr>
</tbody>
</table>

### SolidWorks Errors Related to CAD Integration

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Cause of Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rebuild of Part Failed.</td>
<td>Regeneration failed on update with parameter changes.</td>
</tr>
<tr>
<td>The mechanical database contains unlicensed objects.</td>
<td>Lightweight components (marked with a feather icon in the feature tree) of a SolidWorks assembly must be set to resolved prior to attaching into the ANSYS Mechanical application.</td>
</tr>
</tbody>
</table>
CAD Integration Glossary

The following terms define nomenclature that is unique to ANSYS, Inc. or specialized in meaning.

**Associative Geometry Interface**  The general term for all plug-ins and pseudo-readers.

**Instances**  When multiple copies of the same assembly-part are present in the CAD this preference allows time and memory savings by importing only the first instance of the part within the assembly and creating references to the first part for subsequent instances.

**Reader**  Does not require the CAD system.

**Plug-in**  Requires that the CAD system be running.

**Pseudo-Reader**  CAD system is started by ANSYS Workbench in batch mode and shuts it down after attach/update is completed.

**Additional Glossaries**

Application-specific glossaries are available for the following. Select Add to Favorites in the Favorites menu of the ANSYS Help Viewer to more easily navigate to the paths shown below.

- **ANSYS, Inc. Installation and Licensing Guide**: ANSYS Help System> Installation and Licensing Documentation>ANSYS, Inc. Licensing Guide> Glossary
- **ANSYS CFX**: ANSYS Help System> CFX> CFX Reference Guide> Glossary
- **ANSYS DesignModeler**: ANSYS Help System> DesignModeler> Typical Usage> Glossary
- **ANSYS Mechanical**: ANSYS Help System> Mechanical> Appendices> Glossary of General Terms
- **ANSYS FLUENT**: ANSYS Help System> FLUENT> Getting Started Guide> Glossary of Terms
CAD Integration Updates

For updated CAD-related information, see the customer portal section of the ANSYS, Inc. website. For example, there you can access CAD special versions, standard versions, and archived versions. First-time users of the customer portal must register to create a password. To view additional documentation information and late changes, navigate to Product Information> Product Documentation> Readme files and late document changes.
Index

A
ACIS
  platform/operating system support, 1
  product support, 32
assembly
  support for Autodesk Inventor, 38
  support for CATIA V5, 45, 49
  support for CATIA V6, 52
  support for Creo Parametric, 56
  support for DesignModeler, 66
  support for IGES, 72
  support for Parasolid, 83
  support for Solid Edge, 88
attaching geometry
  from Autodesk Inventor, 38
  from DesignModeler, 66
AutoCAD
  platform/operating system support, 1
  product support, 34
Autodesk Inventor
  named selection import, 1
  platform/operating system support, 1
  product support, 38

C
CAD Integration
  File Format Support, 31
  Frequently Asked Questions, 117
  Glossary, 123
  Installation and Licensing, 27
  Overview, 1
  SpaceClaim, 111
  Teamcenter Connection, 103
  Troubleshooting, 119
  Updates, 125
CAD systems
  geometry interface platform/operating system support, 1
  geometry preferences when attaching, 1
  list of supported systems, 31
  material property transfer, 1
  named selection import, 1
CATIA
  platform/operating system support, 1
  product support for V4, 43
  product support for V5, 45, 49
  product support for V6, 52
components
  naming in Solid Edge, 88
Creo Elements/Direct Modeling
  product support, 54
Creo Parametric
  file versions, 56
  installation notes, 56
  product support, 56
  updating instances, 56
Creo Parametric (formerly Pro/ENGINEER)
  named selection import, 1
  platform/operating system support, 1

D
DesignModeler
  product support, 66
documents
  supported in Solid Edge, 88
  supported in SolidWorks, 94

F
facet limitation in Parasolid, 83
file versions in Creo Parametric, 56

G
GAMBIT
  product support, 70
genus
  CAD interface platform/operating system support, 1
  preferences when attaching, 1
Geometry Interface Support
  Linux, 5
  Windows, 7

I
ids - maintaining associativity of persistent ids in NX, 77
IGES
  platform/operating system support, 1
  product support, 72
importing
  variables from Solid Edge, 88
instances - updating Creo Parametric, 56

J
JT Reader
  product support, 74

L
length unit
  ACIS, 32
  AutoCAD, 34
  Autodesk Inventor, 38
Index

CATIA V4, 43  
CATIA V5, 45, 49  
CATIA V6, 52  
Creo Parametric, 56  
DesignModeler, 66  
IGES, 72  
NX, 77  
Parasolid, 83  
Solid Edge, 88  
SolidWorks, 94

M
material processing transfer from CAD system, 1  
material properties - from NX, 77  
MCNP  
product support, 76, 85, 87  
Monte Carlo N-Particle  
product support, 76, 85, 87  
motion load  
import from Solid Edge, 88  
import from SolidWorks, 94  
multiple file versions  
in Creo Parametric, 56  
in NX, 77

N
Named Selection Manager, 22  
named selections  
CAD input based on entities, 1  
NX  
material properties, 77  
multiple versions, 77  
named selection import, 1  
persistent ids, 77  
platform/operating system support, 1  
product support, 77  
re-registering, 77  
Teamcenter database, 77

P
parameters  
processing CAD, 1  
Parasolid  
platform/operating system support, 1  
product support, 83  
part  
support for Autodesk Inventor, 38  
support for CATIA V5, 45, 49  
support for CATIA V6, 52  
support for Creo Parametric, 56  
support for DesignModeler, 66  
support for IGES, 72  
support for Parasolid, 83  
support for Solid Edge, 88  
platform support - CAD systems, 1  
Plug-In Ribbon  
AutoCAD, 34  
Project Schematic Presence Related to CAD Integration  
Geometry Preferences, 9

R
reader attach/refresh  
AutoCAD, 34

S
Solid Edge  
component naming in assemblies, 88  
importing variables, 88  
motion load import, 88  
named selection import, 1  
platform/operating system support, 1  
product support, 88  
supported documents, 88  
SolidWorks  
motion load import, 94  
named selection import, 1  
platform/operating system support, 1  
product support, 94  
supported documents, 94  
SpaceClaim  
ANSYS SpaceClaim Direct Modeler (SCDM) Behavior in the Project Schematic, 116  
starting the Mechanical Application from Creo Parametric, 56  
supported CAD systems, 31

T
Teamcenter database - use with NX, 77  
Troubleshooting  
ACIS Errors Related to CAD Integration, 120  
Autodesk Errors Related to CAD Integration, 121
CATIA Errors Related to CAD Integration, 121
Creo Parametric Errors Related to CAD Integration, 121
General Errors Related to CAD Integration, 119
NX Errors Related to CAD Integration, 122
Parasolid Errors Related to CAD Integration, 122
Solid Edge Errors Related to CAD Integration, 122
SolidWorks Errors Related to CAD Integration, 122

U
updating instances of Creo Parametric, 56

V
variable
  importing from Solid Edge, 88